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Installation Guide Chapter 1 About Perceptive Intelligent Capture

Perceptive Intelligent Capture is a product suite designed by Perceptive Software, Inc., to
automatically process incoming documents. Perceptive Intelligent Capture works with any
document that is electronically available including scanned images, faxes, e-mails, and files.
Perceptive Intelligent Capture automatically classifies these documents and extracts
meaningful information from them.

Perceptive Intelligent Capture uses a trainable, self-learning algorithm that minimizes user
definition and intervention tasks. The product is based on Perceptive's award-winning
Brainware technology.

Within the Perceptive Intelligent Capture suite, Perceptive Intelligent Capture Designer
enables you to customize the automatic processing of incoming documents, for example,
which document classes are relevant in your enterprise as well as which information is to be
extracted from the classified documents. All custom settings are saved in a Perceptive
Intelligent Capture project file.

To process large volumes of documents, Perceptive Intelligent Capture organizes documents
into batches, which are defined in the Perceptive Intelligent Capture project file. The project
files and stored settings are automatically forwarded to Perceptive Intelligent Capture
Runtime Server for production processing.

Perceptive Intelligent Capture Runtime Server runs unattended as a server process in the
background. Several mechanisms ensure that the system is stable, meaning that it can
automatically recover from most error situations. Multiple instances of Perceptive Intelligent
Capture Runtime Server can be started simultaneously in a network or on a single machine.
These instances cooperate and allow for optimal load distribution.

Batches that cannot be automatically processed in their entirety by Perceptive Intelligent
Capture Runtime Server are forwarded to the quality assurance application Perceptive
Intelligent Capture Verifier for manual correction.

An application module to allow users to verify documents with no software installed on the
client side. The Web Verifier application can be used via Internet Explorer on any client
machine to verify documents. This requires installation and configuration of the project and
batches on the database platform. From version 5.1, Perceptive Intelligent Capture features
a newly implemented Perceptive Intelligent Capture database platform for Perceptive
Intelligent Capture applications. It is possible to store project and authentication information
in the Perceptive Intelligent Capture database. This solution allows for central management
of storage and backup and thus provides for easier security, better connectivity of your
applications, and higher flexibility of your personnel.
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Installation Guide Chapter 2 System Requirements

Chapter 2 System Requirements

2.1 Operating Systems

Using Perceptive Intelligent Capture requires a complete and successful installation of the
software on a server or workstation running one of the following operating systems:

¢ Microsoft Windows Server 2008 R2 (IPv4 and IPv6).

e Microsoft Windows 7

2.2  Perceptive Intelligent Capture Database

The Web Verifier application module requires central management of project data in a
database. The Perceptive Intelligent Capture database has been certified to run on the
following database platforms:

e Microsoft SQL Server 2008 R2
e ORACLE 11g R2

Using Perceptive Intelligent Capture will require .NET Framework 3.5 SP1 installed on the
Perceptive Intelligent Capture server or workstation.

2.3 IS

Using Perceptive Intelligent Capture 5.5 SP1 will require the following software applications
installed on the server:

e [nternet Information Server
e NET Framework 3.5 SP1

For the client browser version side, Internet Explorer 7 and 8 has been certified with
Perceptive Intelligent Capture 5.5 SP1 application.

VMware ESX 4.1 is certified.
2.4  Scripting components

Perceptive Intelligent Capture has been certified for the following supported Scripting
component version:

- WinWrap version 9.0.0.56
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Installation Guide Chapter 3 Hardware Requirements

Before Perceptive Intelligent Capture can be implemented, the underlying network must meet
certain minimum platform and environment requirements.

This section includes information about, and instructions for, configuring basic network
components.

The technology infrastructure underlying Perceptive Intelligent Capture consists of a set of
scalable applications and services running on Microsoft Windows operating systems. These
applications and services are deployed on a set of high-performance Intel-compatible servers
and workstations.

Clients are supported on Intel-compatible workstations running Windows 7.

Perceptive Intelligent Capture is a distributed two-tier application that is typically deployed
across multiple Windows Server operating systems. These applications provide core system
services when connected using an unimpeded high-speed, low-latency network
infrastructure, such as Fast Ethernet (100BaseTX), using TCP/IP.

When implementing a Perceptive Intelligent Capture Project, there are a number of
dependencies which influence the hardware requirements for a Perceptive Intelligent
Capture solution.

This information is typically gathered during the requirements analysis phase of the project
and used as a guideline to aid the project team members responsible for sizing the hardware
and software for the implementation.

The hardware requirements provided in this document can be used as a guideline; it is not a
recommended or required hardware configuration for an implementation of Perceptive
Intelligent Capture. The actual hardware and software configuration for an installation should
be based on the client’s requirements.

Some factors to consider when sizing the hardware for a production environment are:
e Input volume — The number of documents/pages to process on a daily basis

e Completion Time — The required amount of time from when the document is scanned
into the system, to when it is exported out of Perceptive Intelligent Capture

e Complexity of input documents (single or multi-page TIFF, scanned resolution,
document size, number of pages OCR’ed per document, etc.)

o Output requirements (data extraction, validation, and export, nhumber of documents
processed per day, etc.)

o Complexity of workflow customization (scripting)

e Third-party software integration requirements (ORACLE Financials, JD Edwards, SAP,
CRM systems, etc.)

e Backup strategy

o Disaster recovery (backup, fault tolerance, up time, etc.)
¢ Network operating system platform

o Network environment

o Room for growth (increased in input/output and other system requirements)
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Installation Guide Chapter 3 Hardware Requirements

e Users — The number of users (Web Verifier versus Verifier)

¢ Batch Retention Time — The time for a batch of documents to remain in the system after
export

o Number of projects — Number of Perceptive Intelligent Capture projects (per country, per
solution, etc)

¢ Components Installed — Other Perceptive components such as WF-Perceptive Intelligent
Capture and Visibility or databases would likely be installed on another server. [It is
recommended that for a production environment, Perceptive products should be
installed on separate servers.]

The following sections of the document are representations of some Hardware Scenario
configuration.

3.3 Hardware Estimate — 500 PPD
3.3.1. Introduction — AP Project

Based on the standard Perceptive AP Project, the following production system is
recommended.

Assumptions:
e 1-3 page TIFF documents
e Document resolution of 300 dpi
e Average TIFF size of approximately 40KB
e Average WorkDoc size of approximately 21KB
¢ Minimum data extraction and validation (as per the project)
o Project size of less than 5 MB and less than 10 classes
o Cleanup of exported batches (1-3 days)

Note: Disk space requirement is implementation dependent; variables such as document
complexity, scanned resolution, and document volume help determine the amount of disk
space for a project. For example, persistent storage of TIFF images requires
approximately 70 KB per page. In addition, approximately 100 KB per document are
required to temporarily store WorkDocs with OCR results. If PDF file generation is
enabled, another 100 KB per page are temporarily required.

3.3.2. Hardware Estimate — File System (Excl. Web Verifier & Database)

Machine Role Hardware Software Needed
Perceptive Intelligent Required Dual Core Xeon Class, Windows 2008 R2 with the latest service pack
Capture Server (Primary) 2.8 GHz CPU
- File Repository 4 GB RAM Perceptive Intelligent Capture Version 5.5 SP1
- OCR/Classify/Extract 20-40Gb Hard Disk
- Licensing Server Space
Perceptive Licensing
Dongle
Perceptive Intelligent Optional Pentium IV Class, 2.4 Windows 7
Capture Designer GHz CPU (2.8 GHz
Project Design recommended) Perceptive Intelligent Capture Designer Version 5.5
Class Training 1 GB RAM SP1
10 GB hard drive (20 GB
hard drive recommended)
Perceptive Intelligent Required Pentium Class, 2.4 GHz | Windows 7
Capture Verifier, Advanced CPU (2.8 GHz
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Machine Role

Verifier & Learnset
Manager
Data Verification

Hardware

recommended)

1 GB RAM

20 GB hard drive (10 GB
minimum)

Software Needed

Perceptive Intelligent Capture Verifier Version 5.5
SP1

Perceptive Intelligent
Capture Remote Admin
RTS Remote Admini-
stration

Optional

Pentium Class, 2.4 GHz
1 GB RAM

[HD — Application install
only <500Mb]

Windows 7

Perceptive Intelligent Capture Version 5.5 SP1
RTS Remote Admin MMC Snap-in

Table 3-1: Recommended Configuration

3.3.3.

Machine Role

Hardware

Hardware Estimate — SQL Server Database (Excl. Web Verifier)

Software Needed

Capture Remote Admin
RTS Remote
Administration

1 GB RAM
[HD — Application install
only <500Mb]

Perceptive Intelligent Required Quad Core Xeon Class, Windows 2008 R2 with the latest service pack
Capture Server (Primary) 2.8 GHz CPU SQL Server 2008 R2 or ORACLE 10 and above
- File Repository 4 GB RAM
- OCR/Classify/Extract 100Gb Hard Disk Space |.NET Framework 3.5 SP1
- Licensing Server Perceptive Licensing
Dongle Perceptive Intelligent Capture Version 5.5 SP1
Database Server
Perceptive Intelligent Optional Pentium IV Class, 2.4 Windows 7
Capture Designer GHz CPU (2.8 GHz .NET Framework 3.5 SP1
Project Design recommended)
Class Training 1 GB RAM Perceptive Intelligent Capture Designer Version 5.5
10 GB hard drive (20 GB | SP1
hard drive recommended)
Perceptive Intelligent Required Pentium Class, 2.4 GHz
Capture Verifier, CPU (2.8 GHz recom- Windows 7
Advanced Verifier & mended)
Learnset Manager 1 GB RAM .NET Framework 3.5 SP1
Data Verification 20 GB hard drive (10 GB
minimum) Perceptive Intelligent Capture Verifier Version 5.5
SP1
Perceptive Intelligent Optional Pentium Class, 2.4 GHz

Windows 7
.NET Framework 3.5 SP1

Perceptive Intelligent Capture Version 5.5 SP1
RTS Remote Admin MMC Snap-in

Table 3-2: Recommended Configuration

Note: When using ORACLE as a database, it is advised to have an ORACLE client installed
on any workstation/server where Perceptive Intelligent Capture communicates with the

database (Designer, Verifier, etc).

3.3.4. Hardware Estimate — Entire Application Suite

The entire application suite comprises of Perceptive Intelligent Capture Runtime Server, Web

Server, and Database.

Machine Role

Perceptive Intelligent
Capture Server (Primary)
- File Repository

- OCR/Classify/Extract

- Licensing Server

Database Server

Web Server

Required

Hardware

Quad Core Xeon Class,
2.8 GHz CPU

8 GB RAM

100Gb Hard Disk Space
Perceptive Licensing
Dongle

Software Needed

Windows 2008 R2 with the latest service pack

SQL Server 2008 R2 or ORACLE 10 and above
Perceptive Intelligent Capture Designer

IS 6 and above
.NET Framework 3.5 SP1

Perceptive Intelligent Capture
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Machine Role

Hardware

Software Needed

Perceptive Intelligent Capture Version 5.5 SP1

Capture Remote Admin
RTS Remote
Administration

1 GB RAM
[HD — Application install
only <500Mb]

Perceptive Intelligent Optional Pentium IV Class, 2.4
Capture Designer GHz CPU (2.8 GHz Windows 7
Project Design recommended)
Class Training 1 GB RAM .NET Framework 3.5 SP1
10 GB hard drive (20 GB
hard drive recommended) | Perceptive Intelligent Capture Designer Version 5.5
SP1
Perceptive Intelligent Optional Pentium Class, 2.4 GHz
Capture Verifier, CPU (2.8 GHz Windows 7
Advanced Verifier & recommended)
Learnset Manager 1 GB RAM .NET Framework 3.5 SP1
Data Verification 20 GB hard drive (10 GB
minimum) Perceptive Intelligent Capture Verifier Version 5.5
SP1
Perceptive Intelligent Optional Pentium Class, 2.4 GHz
Capture Web Verifier 2GB RAM Windows 7
Internet Explorer 8
Perceptive Intelligent Optional Pentium Class, 2.4 GHz

Windows 7
NET Framework 3.5 SP1

Perceptive Intelligent Capture Version 5.5 SP1
RTS Remote Admin MMC Snap-in

Table 3-3: Recommended Configuration

3.3.5.

Hardware Estimate — Typical Development Environment

A typical development environment consists of one server which processes less than 500
pages per day. The specification below should be sufficient to house the Web Server,
Database, and Perceptive Intelligent Capture Runtime Server.

Machine Role

Perceptive Intelligent
Capture Server (Primary)
- File Repository

- OCR/Classify/Extract

- Licensing Server

- Database Server

- Web Server

Required

Hardware

Quad Core Xeon Class,
2.8 GHz CPU

8 GB RAM

100Gb Hard Disk Space
Perceptive Licensing
Dongle

Software Needed
Windows 2008 R2 with the latest service pack
SQL Server 2008 R2 or ORACLE 10 and above

1IS 6 and above
.NET Framework 3.5 SP1

Perceptive Intelligent Capture Designer

Perceptive Intelligent Capture Version 5.5 SP1

Table 3-4: Recommended Configuration

3.4
3.4.1.

Hardware Estimate — 4000 PPD

Introduction — AP Project

Based on the standard Perceptive AP Project, the following production system

recommended.

Assumptions:

e 1-3 page TIFF documents

e Document resolution of 300 dpi

e Average TIFF size of approximately 60KB

Perceptive Intelligent Capture
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e Average WorkDoc size of approximately 60KB

¢ Minimum data extraction and validation (as per the project)
e Project size of less than 5 MB and less than 10 classes

¢ Cleanup of exported batches (1-3 days).

¢ All documents are provided at the start of the day

Disk space requirement is implementation dependent; variables such as document
complexity, scanned resolution, and document volume help determine the amount of disk
space for a project. For example, persistent storage of TIFF images requires
approximately 70 KB per page. In addition, approximately 100 KB per document are
required to temporarily store WorkDocs with OCR results. If PDF file generation is
enabled, another 100 KB per page are temporarily required.

3.4.2. Hardware Estimate — File System (Excl. Web Verifier & Database)

Machine Role Hardware Software Needed
Perceptive Intelligent Required Quad Core Xeon Class, Windows 2008 R2 with the latest service pack
Capture Server (Primary) 2.8 GHz CPU
- File Repository 8GB RAM Perceptive Intelligent Capture Version 5.5 SP1
- OCR/Classify/Extract 200Gb Hard Disk Space
- Licensing Server Perceptive Licensing
Dongle
Perceptive Intelligent Optional Pentium IV Class, 2.4
Capture Designer GHz CPU (2.8 GHz Windows 7
Project Design recommended)
Class Training 1 GB RAM Perceptive Intelligent Capture Designer Version 5.5

10 GB hard drive hard SP1
drive recommended)

Perceptive Intelligent Required Pentium Class, 2.4 GHz
Capture Verifier, CPU (2.8 GHz Windows 7
Advanced Verifier & recommended)
Learnset Manager 1 GB RAM Perceptive Intelligent Capture Verifier Version 5.5
Data Verification 20 GB hard drive (10 GB | SP1
minimum)
Perceptive Intelligent Optional Pentium Class, 2.4 GHz
Capture Remote Admin 1 GB RAM Windows 7
RTS Remote [HD — Application install
Administration only <500Mb] Perceptive Intelligent Capture Version 5.5 SP1

RTS Remote Admin MMC Snap-in

Table 3-5: Recommended Configuration

3.4.3. Hardware Estimate — SQL Server Database (Excl. Web Verifier)

Machine Role Hardware Software Needed
Perceptive Intelligent Required Quad Core Xeon Class, Windows 2008 R2 with the latest service pack
Capture Server (Primary) 2.8 GHz CPU
- File Repository 8 GB RAM SQL Server 2008 R2 or ORACLE 10 and above
- OCR/Classify/Extract 200Gb Hard Disk Space
- Licensing Server Perceptive Licensing .NET Framework 3.5 SP1
Dongle
Database Server Perceptive Intelligent Capture Version 5.5 SP1
Perceptive Intelligent Optional Pentium IV Class, 2.4
Capture Designer GHz CPU (2.8 GHz Windows 7
Project Design recommended)
Class Training 1 GB RAM .NET Framework 3.5 SP1
10 GB hard drive (20 GB
hard drive recommended) | Perceptive Intelligent Capture Designer Version 5.5
SP1
Perceptive Intelligent Required Pentium Class, 2.4 GHz | Windows 7
Capture Verifier, CPU (2.8 GHz
Advanced Verifier & recommended) .NET Framework 3.5 SP1
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Machine Role

Learnset Manager
Data Verification

Hardware

1 GB RAM
20 GB hard drive (10 GB
minimum)

Software Needed

Perceptive Intelligent Capture Verifier Version 5.5
SP1

Perceptive Intelligent
Capture Remote Admin
RTS Remote
Administration

Optional

Pentium Class, 2.4 GHz
1 GB RAM

[HD — Application install
only <500Mb]

Windows 7
.NET Framework 3.5 SP1

Perceptive Intelligent Capture Version 5.5 SP1
RTS Remote Admin MMC Snap-in

Table 3-6: Recommended Configuration

When using ORACLE as a database, it is advised to have an ORACLE client installed on
any workstation/server where Perceptive Intelligent Capture communicates with the

database (Designer, Verifier, etc).

3.4.4. Hardware Estimate — Entire Application Suite

The entire application suite comprises of Perceptive Intelligent Capture Runtime Server, Web

Server, and Database.

Machine Role

Hardware

Software Needed

Capture Remote Admin
RTS Remote
Administration

1 GB RAM
[HD — Application install
only <500Mb]

Perceptive Intelligent Required Quad Core Xeon Class, |Windows 2008 R2 with the latest service pack
Capture Server (Primary) 2.8 GHz CPU
- File Repository 8 GB RAM SQL Server 2008 R2 or ORACLE 10 and above
- OCR/Classify/Extract 100Gb Hard Disk Space
- Licensing Server Perceptive Licensing 11S 6 and above
Dongle .NET Framework 3.5 SP1
Database Server
Perceptive Intelligent Capture Version 5.5 SP1
Perceptive Intelligent Required Dual Core Xeon Class, Windows 2008 R2 with the latest service pack
Capture Web Server 2.8 GHz CPU
4 GB RAM SQL Server 2008 R2 or ORACLE 10 and above
50Gb Hard Disk Space
30Gb OS Hard Disk Perceptive Intelligent Capture Designer
Space
IIS 6 and above
.NET Framework 3.5 SP1
Perceptive Intelligent Capture Version 5.5 SP1
Perceptive Intelligent Optional Pentium IV Class, 2.4
Capture Designer GHz CPU (2.8 GHz Windows 7
Project Design recommended)
Class Training 1 GB RAM .NET Framework 3.5 SP1
10 GB hard drive (20 GB
hard drive recommended) | Perceptive Intelligent Capture Designer Version 5.5
SP1
Perceptive Intelligent Optional Pentium Class, 2.4 GHz | Windows 7
Capture Verifier, Advanced CPU (2.8 GHz
Verifier & Learnset recommended) .NET Framework 3.5 SP1
Manager 1 GB RAM
Data Verification 20 GB hard drive (10 GB | Perceptive Intelligent Capture Verifier Version 5.5
minimum) SP1
Perceptive Intelligent Optional Pentium Class, 2.4 GHz | Windows 7
Capture Web Verifier 2GB RAM
Internet Explorer 8
Perceptive Intelligent Optional Pentium Class, 2.4 GHz | Windows 7

.NET Framework 3.5 SP1

Perceptive Intelligent Capture Version 5.5 SP1
RTS Remote Admin MMC Snap-in

Table 3-7: Recommended Configuration

Perceptive Intelligent Capture
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3.4.5.

Web Verifier Server Hardware Sizing — Additional Information

Additional Web Server considerations depend on the number of Verifier users.

Number of Users

‘ Memory Processor

Per User 150Mb Peak Load 100% of a 3GHz CPU
0-10 Users 4 Gb Dual Core CPU
11-20 Users 8 Gb Quad Core CPU

Table 3-8: Recommended Configuration

Factors which influence the metrics are:

e Project size and complexity

e Other software stored on the server

e Third party software integration

e Network connections

e Document Sizes

o Project Type

Machine Role

Perceptive Intelligent
Capture Server
(Primary)

Project File (.SDP)
Batch Directory
Stores Images
Workdocs

Input Directory
Learnset

License Server

‘ Hardware

Xeon Class, 2.4 GHz CPU

2 GB RAM

Three or more 36 GB (40 GB
recommended) + Hot
Swappable hard drive

RAID Controller (for fault
tolerance)

Dongle

Software Needed

Windows 2008 R2 with the latest service pack
Microsoft .Net Framework 3.5 SP1
Perceptive Intelligent Capture Version 5.5 SP1

Perceptive Intelligent
Capture RTS
Performs OCR
Classification

Data Extraction
Export

System Clean-up

Dual Xeon Class, 2.8 GHz
CPU

2 GB RAM (1 GB minimum)
40 GB hard drive

Windows 2008 R2 with the latest service pack
Microsoft .Net Framework 3.5 SP1
Perceptive Intelligent Capture Version 5.5 SP1

Perceptive Intelligent
Capture Designer
Project Design
Class Training

Pentium IV Class, 2.4 GHz
CPU (2.8 GHz recommended)
1 GB RAM

10 GB hard drive (20 GB hard
drive recommended)

{xe Windows 7} Windows 7, or Windows 2008 R2
Microsoft .Net Framework 3.5 SP1
Perceptive Intelligent Capture Designer Version 5.5 SP1

Perceptive Intelligent
Capture Verifier,
Advanced Verifier &
Learnset Manager
Data Verification

Pentium Class, 2.4 GHz CPU
(2.8 GHz recommended)

1 GB RAM

20 GB hard drive (10 GB
minimum)

{xe Windows 7} Windows 7, or Windows 2008 R2
Microsoft .Net Framework 3.5 SP1
Perceptive Intelligent Capture Verifier Version 5.5 SP1

Perceptive Intelligent
Capture Remote Admin
RTS Remote
Administration

Pentium Class, 2.4 GHz CPU
(2.8 GHz recommended)

1 GB RAM

10 GB hard drive

Windows 7, or Windows 2008 R2
Perceptive Intelligent Capture Version 5.5 SP1
RTS Remote Admin MMC Snap-in

Perceptive Intelligent
Capture Web Verifier
Server

Pentium Class, 2.4 GHz CPU
(2.8 GHz recommended)
1 GB RAM

{xe Windows 7} Windows 7, or Windows 2008 R2
Microsoft .Net Framework 3.5 SP1
Internet Information Server (1IS) 6.0 or higher

Perceptive Intelligent Capture
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Machine Role Hardware Software Needed

10 GB hard drive Perceptive Intelligent Capture Version 5.5 SP1

Table 3-9: Recommended Configuration

3.5 Infrastructure Constraints

Perceptive Intelligent Capture has been fully tested and is certified to work in most LAN
environments. By adhering to the following infrastructure constraints, you can ensure a
smooth implementation of the product suite.

3.5.1. OCR Performance

OCR is a processor-intensive task. To maximize OCR performance, we recommend that only
one RTS OCR instance is active per CPU on a production server. Although it is possible to
run multiple RTS OCR instances on a single CPU, doing so may impair the performance of
OCR and the overall system.

3.5.2. Firewalls

Perceptive Intelligent Capture is designed to work in a non-encapsulated LAN environment.
A non-encapsulated LAN, in this context, is a LAN segment free of impediments such as
firewalls and other traffic-filtering devices.

With multi-site network environments, it is the responsibility of the customer’s IT personnel to
ensure that an unobstructed communication path exists between the user community and
host system.

3.6 RTS Remote Administration MMC

You can remotely administer Perceptive Intelligent Capture Runtime Server, meaning that
you can centrally manage multiple Runtime Servers from a single workstation on the network
using a management console snap-in called the RTS Remote Administration MMC.

However, to use the RTS Remote Administration MMC snap-in, the administrator workstation
must either reside on the same LAN segment as the RTS server services to be centrally
administered or, in the case of a sub-netted network, a name resolution system must be in
place to allow clients on one subnet to locate resources on another subnet.

Remote Administration by MMC requires one free configurable port number. The default port
is 50607.

The Windows service Perceptive Intelligent Capture Service Manager must be running in
order to be able to connect by MMC to the Runtime Server service. Once the service is
running, it is possible to start and stop each Runtime Server instance separately.

As long as the configured port is available in any TCP/IP network (or Internet across
firewalls) and the main service is running, the MMC can be used to configure and maintain
the Runtime Server instances.
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Chapter 4 Pre-Installation of Perceptive Intelligent
Capture

When you are ready to install Perceptive Intelligent Capture, there are several steps you
should take to ensure that the installation goes smoothly. This section includes information
about the following:

e Backward compatibility with other Perceptive applications

e Upgrading from previous versions of Perceptive Intelligent Capture

¢ Uninstalling Perceptive Intelligent Capture Versions 4.x

¢ |Installing Perceptive Intelligent Capture Version 5.5 SP1 in standalone mode
¢ Installing Perceptive Intelligent Capture Version 5.5 SP1

e Checking the installation

¢ Migrating existing project files to Version 5.5 SP1

¢ Uninstalling Perceptive Intelligent Capture Version 5.5 SP1

¢ Repairing Perceptive Intelligent Capture Version 5.5 SP1

e Adding or removing product components

4.1 Before Installing Perceptive Intelligent Capture

Before starting the installation, make sure that you have local administrator rights on the
target machine. During the installation, a number of DLLs will be copied to the Windows
system directory and registered with the operating system.The Perceptive Intelligent Capture
database will be created on the SQL Server or ORACLE servers. The install process
requires administrative privileges and access to the Windows registry.

The installation media contains the following folders:

e \Install contains the setup executables of the Perceptive Intelligent Capture product
suite.

¢ \Instal\doc contains Perceptive Intelligent Capture product documentation.
4.1.1. Installation Checklist

The checklist below is designed to help you install and configure Perceptive Intelligent
Capture in your environment.

O If you are installing Perceptive Intelligent Capture in a standalone mode (a non-network
test or demo installation,) do only the steps outlined in and skip the
rest of the installation checklist.

O If you are upgrading from a previous version of Perceptive Intelligent Capture, read
section and do the steps outlined in that
section before continuing with the installation checklist.

O If your organization uses other Perceptive products, read section
before proceeding with the
installation checklist.

O Read
O Configure the SQL Server / ORACLE software.

O If following the Microsoft recommended resource rights assignment model, create the
users and groups.
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O Install Perceptive Intelligent Capture Version 5.5 SP1. (Chapter 5 Installing Perceptive
Intelligent Capture)

O Configure the Runtime Components. (Chapter 8 Configuring Runtime Components)

O Configure the Runtime Service Manager (Section
).
O Start the Runtime Service Manager.

O Configure the RTS RemoteAdmin MMC shap-in (Section
).

O Test the installation (See the Perceptive Intelligent Capture Runtime Server User
Guide).

O Configure license and project settings for an instance. (See the Perceptive Intelligent
Capture Runtime Server User’s Guide.)

O Process a batch (minimum workflow steps: OCR, Classification, and Extraction).

O If using Web Verifier, configure the 1IS and .NET along with application security. (See
Chapter 6 )

4.2 Backward Compatibility with Other Perceptive Applications

Perceptive Intelligent Capture is part of the Perceptive line of application suites branded
Perceptive. These products share common components based on the award-winning
Perceptive technology.

Note: Perceptive Intelligent Capture Version 5.5 SP1 is fully backward compatible with
Version 3.0/4.0/4.1 of Perceptive Intelligent Capture but not with earlier versions. It is
not compatible with versions of Perceptive Intelligent Capture earlier than 3.0.

If your organization uses Capture (in conjunction with older versions of Perceptive Intelligent
Capture) and you want to upgrade to Perceptive Intelligent Capture Version 5.5 SP1, you
must also upgrade to Capture Version 5.5 SP1.

For earlier versions of Perceptive Intelligent Capture 3.0 and below, please contact
Professional Services to assist in the upgrade of your project(s).

Note: Effective immediately, all new Perceptive Intelligent Capture implementations use the
Database option, not the File System option. Release 5.3 SP2 is the last release that
supports the File System option. If you want to take full advantage of the new features in
versions beyond 5.3 SP2, please upgrade to a Database system.

Note: Perceptive recommends engaging Professional Services to ensure a successful and
smooth installation of the software.

4.3  Perceptive Intelligent Capture License File

Perceptive Intelligent Capture version 5.5 SP1 requires a new license file. Please contact
Perceptive Customer Support to convert your existing license to a version 5.5 SP1 license
file.

4.4  Perceptive Intelligent Capture Database Checklist
4.4.1. Perceptive Intelligent Capture Database

Perceptive Intelligent Capture version 5.5 SP1 is able to store the following Perceptive
Intelligent Capture core information directly in the Perceptive Intelligent Capture database,
instead of the file system:
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Documents

Batches (jobs)

Images and document files in e-format
Project references

Users, groups, roles and relationships
Verifier configuration (Web Verifier only)
Batch/Document lock handling

Application level user licensing

File system functionality is no longer supported. Customers with file system based batches
that want to upgrade to versions beyond 5.3 SP2 will be required to upgrade to database
based batches.

Prior to installation of Perceptive Intelligent Capture, some care must be taken to make sure
that the appropriate configuration steps have been taken.

Perceptive Intelligent Capture will need to create the following items prior to the installation of
the software:

1.

An administrative database account with rights to create, modify, and delete tables.
Windows Authentication can be used if the user performing the installation has
administrative rights to the database server.

A designated user database account which will be used by Perceptive Intelligent
Capture to access the database, add, modify, and delete data. Windows Authentication
can be used if the user performing the installation has the appropriate rights to the
database server.

Perceptive Intelligent Capture will need the following items taken care of prior to the
installation of the software:

1.
2.
3.

Create a new ORACLE instance for Perceptive, name it Perceptive Intelligent Capture.
Create a new user called Perceptive with a password.

Assign sufficient rights to the above user:

a. Allow for increased growth of data.

b. Allow for insertion, modification, and deletion of data.

c. Allow for table, views, etc. creation.

Administrative database accounts with rights to create, modify, and delete tables.
Windows Authentication can be used if the user performing the installation has
administrative rights to the database server.

A designated user database account which will be used by Perceptive Intelligent
Capture to access the database, add, modify, and delete data. Windows Authentication
can be used if the user performing the installation has the appropriate rights to the
database server.
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4.5 Upgrading from Previous Versions of Perceptive Intelligent
Capture

4.5.1. Perceptive Intelligent Capture Versions 1.3x and 2.x

The earlier versions of Perceptive Intelligent Capture, 1.3x and 2.x, require Professional
Services/Perceptive assistance in upgrading as there have been several changes in the
software architecture.

4.5.2. Upgrading from Version 5.3 or later Versions

The installation process provides a Repair option to upgrade version 5.3 or later versions to
to 5.5 SP1. For details refer to the Product Migration Guide.

4.5.3. Upgrading from versions prior to 5.3

Due to the Perceptive Intelligent Capture database focusing from version 5.3 on which has to
be established during the setup process, Perceptive Intelligent Capture versions previous to
5.3 must be uninstalled prior to installation of version 5.5 SP1.

4.6 Removing Perceptive Intelligent Capture Versions 3.0, 4.0,
and 4.1

It is recommended to uninstall any previous versions of Perceptive Intelligent Capture prior to
installing Perceptive Intelligent Capture 5.5 SP1.

The uninstaller may not remove several registry entries and subdirectories adequately. For
this reason, they must be removed manually. Please follow the procedure below to properly
remove the older version of Perceptive Intelligent Capture before installing Version 5.5 SP1.

Important: Following these instructions will remove some of the files and registry entries
that are used by other Perceptive products (Steps 7 below) and render the products
unusable. If you already have other Perceptive products installed, expand the affected
folders and registry keys and delete only the subfolders and sub-registry values that are
specific to Perceptive Intelligent Capture.

To remove previous versions of Perceptive Intelligent Capture:
1) Select Start>Settings>Control Panel.
2) Launch the Add/Remove Program wizard.

3) On the Currently Installed Programs list, select
the Perceptive Intelligent Capture version you want to remove.

4) Click Change/Remove.
5) Follow the on-screen instructions to remove the product.
6) Click Finish.

7) Save any permanent license files in the
...\<Application folder>\Component\Cairo directory before deleting the ...\<Application
folder> folder.
Save the FineReader FRELF file if FineReader 8.1 or FineReader 10 is used.

If there are other Perceptive products installed, do not delete the ...\Cairo and ...\Cedar
sub-directories and any registry keys specific to those applications. Also, if there are any
project files stored below the ...\<Application folder> folder, you should move them
before deleting the folder.)

8) Remove the ...\<Application folder> subdirectory.

9) Restart the machine.
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10) Install Perceptive Intelligent Capture Version 5.5 SP1.

Note: Perceptive Intelligent Capture Runtime Server Settings and Verifier Settings files
can be reused in the new version. It is recommended to save these prior to un-
installation and reuse them when configuring a new Runtime Server or Verifier
Workstation.
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Chapter 5 Installing Perceptive Intelligent Capture
5.1 Software Installation

Note: You must first install .NET Framework 3.5 SP1 prior to installing Perceptive
Intelligent Capture.

To install Perceptive Intelligent Capture:
1) Browse to the installation folder and run setup.exe.

2) English and German are the supported installation languages. The installer gets its
language settings from the regional settings of the operating system. The installation
defaults to English if a language other than English or German is detected.

3) Make sure that all Perceptive Intelligent Capture applications are closed.

Figure 5-1: Active Applications warning window
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Figure 5-2: Missing .Net framework Version warning window

ik —

Figure 5-3: Start Setup dialog box

4) Click Next to continue.

5) Select the installation type: Complete or Custom
Complete: Installs the most common options:
Perceptive Intelligent Capture Designer, Runtime Server, and Thick/Web Verifier.
OCR Engines FineReader8.1, FineReader 10, Kadmos 5, Recognita, QualitySoft, and
Clegs Barcode.

Default Folder: SystemDrive:\Program Files\Perceptive.
Default Program Group: Perceptive Intelligent Capture.
Custom: It enables you to install only the components you will use.
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Setup Type

setup type.

atures will be installed. [Requires t

alled. Recommended for advanced

i | [ | e | Cwed ||

Figure 5-4: Setup Type selections in installation.

6) For a complete installation choose Complete and press Next. This will run the typical
installation and install all optional components. Go to section 5.1.2 Program Folder and
Auto Update to complete the setup. By default, the Demo License is included.

7) For a custom installation choose Custom and press Next. Read the next chapter for
details.

5.1.1. Selecting Custom Installation

If you selected Custom on the Setup Type screen, you can select the installation directory, the
features and other components.
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Inztallation Directory
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Figure 5-5: Installation directory dialog box

Feature Selection
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-] Runtime Service
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Bl Dema Files
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| FineReader 8.1
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Figure 5-6: Select or deselect applications and components.

For a custom installation:

1) First choose the installation directory.

2) In Feature Selection dialog box, select the desired applications.

3) Inthe OCR components list, you can select the optional components used for Barcode
recognition and Handprint OCR.
Only components selected during the installation will be available. However, you can
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always add more components later. (See section 5.11 Adding or Removing Version 5.5
SP1 Components).

4) Select or deselect Demo Project if this is a custom installation.
5) Click Next.

Note: Optional components must be acquired separately and require separate licensing.

Optional components

Cleqgs Barcode Reads handwritten and machine-printed data and barcode information. It reads 18
Engine: types of barcodes.

FineReader8.1 OCR | Converts paper-based or scanned images into editable text. Supports English,
Engine: German, Italian, French, and Spanish.

FineReader10 OCR Now supporting Chinese/Korean/Japanese characters in addition to English, German,

Engine: Italian, French, and Spanish. Converts paper-based or scanned images into editable
text.

Kadmos5 OCR Used for handwriting recognition.

Engine:

Recognita Engine: Supports 75 languages and more than 100 scanner models.

QualitySoft Barcode Support grayscale and color images. QualitySoft recognizes 19 different barcode
Engine types.

Table 5-1: List of available OCR components
5.1.2. Program Folder and Auto Update
For either a typical or custom installation:

1) Select the desired applications for the Auto Update Feature. Furthermore you can enter
the path for the Shared Network Updates Directory here. (See Chapter 9)

Configuration of Auto Update Feature

pour machine.

Shared network update tory:

W ot etworklnstallS erver ame Y ourl nstalls hareM ame _

Mate: To enable auta-u

i —
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Figure 5-7: Configuration of Auto Update Feature dialog box
2) Click Next.

3) In the Select Program Folder screen, select an existing program folder or a new folder for
the Perceptive Intelligent Capture program icons. The default setting is
Perceptive\Perceptive Intelligent Capture.

Program Folder

“f'ou may type a new folder name,

Accessonies

Adminigtrative Tools

FileZilla FTP Client

Microzoft SOL Server 2005
Microzoft Visual Studio 2005
Maotepad++

Oracle - OraDb10g_harnel
Startup

TreeSize Free

InistalEfield

Figure 5-8: Select Program Folder dialog
4) Click Next.
5.1.3. Finishing Typical and Custom Installations

5) Verify that the selected components are listed on the Selected Install Options dialog box
and click Next.
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Selected Install Options

Setup Directon: C:A\Program FilesWdmmess

Prograr falder

[ e L

Mon Optional Features:

- Caira Companents

- Cedar Components

- BwWE Components

- Additional Application Files
- Tools

- Script Engines

Inistal 5tield < Back Cancel

Figure 5-9: Selected Install Options window

6) At the WIBU-KEY Runtime-Kit pop-up window, click Yes to install the
Runtime-Kit.

WIBU-KEY Runtime-Kit ¥6.00 32-Bit Installation

‘iibi-Key is required For licensing!

\i:)' WIEL-KEY Runtime-Kit will be installed now.
-
Do you wank to execute the setup For "WIBLU-KEY Runkime-kit'?

Figure 5-10: The WIBU-KEY installation dialog box.

7) The setup creates several subdirectories below the installation directory:

- \Components\Cairo contains the Perceptive base components for imaging and
recognition. In a complete installation there are several subdirectories with third party
libraries: Accusoft, Clegs Barcode, FineReader, Kadmos, Recognita, INSO, and LDF. This
directory also contains the master license file.

- \Components\Cedar contains the Perceptive base components for document analysis.
There is one subdirectory for each supported language and a subdirectory with a third
party library, FindLink.

- \Components\Tools contains the installation log file, component version information, and
other tools/utilities for Perceptive Intelligent Capture.

- \Projects contains demo projects.
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- \Perceptive Intelligent Capture\bin contains the Perceptive Intelligent Capture Designer
executable DstDsr.exe, the Perceptive Intelligent Capture Runtime Server executables
DstMgr.exe and DstHost.exe, the Perceptive Intelligent Capture Supervised Learning
Manager executable DstSIm.exe, and the Perceptive Intelligent Capture Verifier
executable DstVer.exe. It also contains the settings files.

- \Perceptive Intelligent Capture\bin\Log contains the log files of the Perceptive Intelligent
Capture Runtime Server.

- \Perceptive Intelligent Capture Web Server contains the Perceptive Intelligent Capture
Web components, the Web.Config file, and other web libraries used by the Web Verifier.

5.1.4. Perceptive Intelligent Capture Database Setup

8) Now, the dialog box for the Perceptive Intelligent Capture Database setup appears.

Database Setup Options

Il Database

Inistal(stied

Figure 5-11: Database Setup Options dialog box

9) After selection of the desired server, click Next. Go to number 13) for the Oracle
configuration or to number 10) for SQL configuration. If you want to end the installation
without installing the Database, go to section 5.1.5 Completing the Perceptive
Intelligent Capture Setup.

For SQL Server:

10) Enter the name of your Database server. You will find it in the SQL Server Configuration
Manager.
The setup will search for the SQL Server, connects with it and creates a new database
with the table name Perceptive Intelligent Capture.
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Databaze Server Information [SOL Server)

T Fame:

SERYERWROJECT

4
Database detection...

It [ Caticel |

Figure 5-12: Database Server Information for SQL Server dialog box
Very Important!

Please note, if you already have a Perceptive Intelligent Capture Database installed, this
Database will be overwritten by this installation process. The following window appears in
this case:

Exizting D atabase Detected

acked up befare continuing.

iz  Cees ||

Figure 5-13: existing Perceptive Intelligent Capture Database detected dialog box

If you want to save your existing Database, back it up before continuing. This applies for the
installation of a new version on the same machine.

If you want to keep your current installation but want to install Perceptive Intelligent Capture e.
g. on an additional Runtime Server machine, you can keep your existing Database by copying
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all of the configuration files (web.config and .config files in \Perceptive Intelligent Capture\bin)
from the existing installation folder Perceptive Intelligent Capture\bin to the new setup folder.

11) Enter your logon information for the Database or use the Windows Authentication. You will
also have to setup logon information for the newly implemented Database on the SQL
Server level.

Login Credentials

Enter SAL Server administration credentials:

v hehtication

Usger |D:

Pesvos.

st ook [ ncu, [ o )

Figure 5-14: Selection for Windows Authentication

If you already have created login credentials for the server, you can enter them in this
dialog box.

r adminiztration credentials:

mz Authentication

dzer D DBUser

Figure 5-15: Administrative credentials for SQL Server dialog box
12) Click Next.
For Oracle:

13) Provide your login credentials. This will need to be an Administrative account which had
access to create tables, views, etc in the database.
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Login Credentials

e ] e P wew T o ]

Figure 5-16: Database credentials for Oracle dialog box

14) Enter the name of your Database server. As default, it is your Machine name/Server
name.

Database Server Information [Oracle]

Dat FIanne:

SERVERYPROJECT

Inista(lEtield [ Cancel |

Figure 5-17: Database Server Information for Oracle dialog box

15) Click Next.
5.1.5. Completing the Perceptive Intelligent Capture Setup
16) The final part of the installation confirms components that have been installed.
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Performed Tasks

ETART INSTALLATION

Copying installation files .. Donel
Creating/lJpdating registy entriez  ...Donel
Copy License Information ... Daonel
Creating entries in start menw ... Danel
Registering installed components ...Donel

izl e T I =

Figure 5-18: Confirmation of installation steps.

17) Select Next to continue.

18) You will be presented with a screen to confirm if you want to have desktop icons created
for Perceptive Intelligent Capture application. Tick the checkbox if you want Desktop
icons.

Icons on Desktop

alled Foomiommn - iosinm 7

far applic:

o [ e [ e [ e [

Figure 5-19: Icons on desktop dialog.

19) Select Finish, to complete the installation.
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Note: In version 5.5 SP1, French language is supported for Verifier, Web Verifier, and
Learnset Manager. In order to enable French language, you have to select the language on
the Formats tab of your system’s Regional and Language Options.

It is also possible to install the database manually. This can be due to corporate policies. In
such an instance, the following steps can be taken to install and configure the database
manually:

1) Launch Windows Explorer and navigate to the installation folder. Navigate to
<installerFolderLocation>\FirstPart\Database\CreationScripts.

There are two folders, SQL Server and ORACLE. Each folder contains database scripts to
execute that will create the tables, views, indexes, and default data values.

2) Open the database configuration panel
SQL Server: Management Console.

- Log into the database with Administrator rights

- Create a new database

- Run the SQL scripts to create the appropriate values.
ORACLE: SQLPIlus or ORACLE Management Console

- Follow the steps outlined earlier in this document in configuring the database prior to
ORACLE installation. (See section 4.4.3 Perceptive Intelligent Capture ORACLE
Checklist)

- Log into the database with user account where the tables will be located.
- Run the database script to create the appropriate values.

3) Navigate to
<installerFolderLocation>\FirstPart\Database\UpdateScripts
Again, you will find folders for the SQL and the Oracle scripts.

4) Edit the Update Database script:
e in Oracle script: TargetbBSchemaName
e in MS SQL script: TargetDatabaseName

Note: If you refrain from executing the steps outlined above, an error message will
turn up on running of the Update Scripts.

5) Run the Update Database script.

6) Check that the database tables have been created correctly and no errors were reported
on execution of the database scripts.

7) There are several configuration components that require modification. Navigate to the
Perceptive installation folder. By default this is located in Program Files\Perceptive.

8) Navigate to the Perceptive Intelligent Capture Web Server folder and open the Web.config
file in Notepad.

9) Search for the connection string in the file.
<connectionStrings></connectionStrings>

10) Modify the connection string to connect to the database.
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SOLServer Example

<connectionStrings>

<add name="Entities" connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity.Entities.ssdl|res://*/Entity.Entities.msl;
provider=System.Data.SqlClient; provider connection string=&quot;Data Source=DBINSTANCE\SQLEXPRESS,; Initial
Catalog=SQLServerDatabaseCatalog;Integrated Security=false;User
ID=Perceptive;Password=Perceptive;MultipleActiveResultSets=True&quot;" providerName="System.Data.EntityClient" />

</connectionStrings>

ORACLE Example

<connectionStrings>

<add name="Entities"
connectionString="metadata=res://*/Entity. ORAERntities.csdl|res://*/Entity. ORAEntities.ssdl|res://*/Entity. ORAEntities.msl;
provider=EFOracleProvider; Provider Connection String='Data Source=OracleServerName;User
Id=Perceptive;Password=Perceptive™ providerName="System.Data.EntityClient" />

</connectionStrings>

11) Navigate to the Perceptive Intelligent Capture\bin folder.

12) There are 6 other configuration files which require changing as with the web.config. These
are DstDsr.exe.config, DstHost.exe.config, DstSIm.exe.config,
Brainware.System.Project.config, DstVer.exe.config, and DstWkBrw.exe.config. Open
each one in Notepad to make the appropriate changes below.

13) Search for the connection string in the file.
<connectionStrings></connectionStrings>

Modify the connection string to connect to the database. (Refer to Step 10 for examples)

14) For ORACLE installation, it is required to make one more addition to the .NET installation
for the ORACLE connection string above to work.

- Navigate to the Windows folder using Windows Explorer

- Navigate to WINDOW S\Microsoft. NET\Framework\ v2.0.50727\CONFIG

- Open the machine.config file for editing and location the DbProviderfactories tag.
- Add the lines below and do not delete any existing data.

<system.data>
<DbProviderFactories>

<add name="EF Oracle Data Provider" invariant="EFOracleProvider" description="EF Provider for Oracle testing"
type="EFOracleProvider.EFOracleProviderFactory, EFOracleProvider, Version=1.0.0.0, Culture=neutral,
PublicKeyToken=def642f226e0e59b"/>

</DbProviderFactories>

</system.data>

5.3 Configuring the Perceptive Intelligent Capture database (post
install)

After the installation of Perceptive Intelligent Capture with Database there are additional
configuration steps that are required.
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1. Check the project file names. The project file name will be used to display the available
project lists in Web Verifier.

2. Review the list of users in the projects.
- All usernames and passwords must be consistent throughout all project files.
- Each user must have their own username and password — user IDs cannot be shared.

3. Export the users from the project file into the Perceptive Intelligent Capture database. This
will now make users available to access projects via the Web Verifier.

4. Log into the User table (known in ORACLE as USER ) and for each user, add a
Forename and Surname into the Perceptive Intelligent Capture database.

5. Create a Runtime Server instance for the project, or import existing Runtime Server
settings, and configure again the Perceptive Intelligent Capture database (creating a job
and linking to the Perceptive Intelligent Capture database).

You are now ready to use Perceptive Intelligent Capture with Perceptive Intelligent Capture
database.

See Also:

For information on how to configure a project for a Perceptive Intelligent Capture instance
with Perceptive Intelligent Capture database, or to migrate file system batches to the
Perceptive Intelligent Capture database, see the Perceptive Intelligent Capture Runtime
Server User’s Guide.

In order to achieve better compatibility of Visual Studio (VS) 6, Perceptive Intelligent
Capture5.5 SP1 introduces an intermediate wrapper component for Workflow History related
operations.

The component Cedar Workflow History Wrapper (CdrwH.dll) has to be installed and
registered in \Perceptive\Components\Cedar directory.

The component is a COM component created with VS 2008 (V9) C++ and wraps the currently
available base component for Workflow History operations, which is the Cedar Database
Access component (CdrDB.dll).

To access the Workflow History functionality, the CdrwH.dll should be used instead of the
CdrDB.dIL.

A Windows Workgroup, also referred to as Peer-to-Peer networking, is a network
implementation of Windows-based operating systems (clients and servers) in which there is no
central security authority (domain controller) responsible for user authentication or a central
repository (such as Active Directory) for locating network resources.

In such a network, each machine is responsible for securing its resources, and users needing
access to a resource located on a machine must have an account defined on that machine.
Windows Workgroup networking should only be used when you want to set up communication
between a limited number of computers (less than 10) and the machines are not members of a
Windows domain.

For an implementation of Perceptive Intelligent Capture in corporate network environments
that are standardized on network operating systems (servers) other than Windows — Novell
Netware — a Windows Workgroup setup may be the only choice. To install Perceptive
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Intelligent Capture in Windows Workgroup, perform the following steps (you must be logged
on as an Administrator):

1) Create a user with the same name on each Perceptive Intelligent Capture machine.
Perceptive recommends Perceptive Intelligent Capture RTSsvc as the user name. (This
does not apply to machines that will be used only as a Designer or Verifier workstation.)

2) Add the above user to the local Administrators group on each Perceptive Intelligent
Capture server.

3) Install Perceptive Intelligent Capture on each machine by following the steps in Section

4) Configure and start the Runtime Service Manager by performing the steps in Section
on each machine, with the following
exception: Wherever a domain user is requested, add the user created in step 1 above.

5) Configure the RTS Remote Administration MMC snap-in by performing the steps in
Section on each machine.

6) Configure project settings on each machine and test the instance created in Step 5 above.
You should (at a minimum) test the OCR, Classification, and Extraction workflow steps.
For more information on how to configure project settings for a Perceptive Intelligent
Capture RTS instance, see the Perceptive Intelligent Capture Runtime Server User’s
Guide.

7) Once you have successfully tested each machine, test remote communication by adding a
remote machine to the local MMC snap-in of one your servers. You can accomplish this by
performing a subset of the steps (Steps 4 through 7) in Section

8) You should be able to administer the RTS instances (start, stop, change batch states, etc.)
of the remote machine from the MMC snap-in of the local machine on which it was added.

Perceptive Intelligent Capture can be deployed in a standalone mode. However, this
implementation method is intended for test and demonstration purposes only. It should NOT
be used in a production environment. Deployment of

Perceptive Intelligent Capture in Standalone mode for production purposes would be deemed
unsupported by Perceptive.

In this setup, all Perceptive Intelligent Capture components (applications, RTS, Remote Admin
MMC snap-in, etc.) are installed and intended to be used on a single machine. Additionally,
the integrated machine is not part of a Windows domain or is not intended to communicate
with Perceptive Intelligent Capture RTS instances running on other machine(s) in a network
environment.

Using this setup, almost all of the configuration constraints (Windows domain, Users and
Groups, etc.) can be ignored.

To install Perceptive Intelligent Capture in a standalone mode:
1) Attach your supplied hardware key (serial or USB dongle) to the machine.

2) Install Perceptive Intelligent Capture Version 5.5 SP1 by following the steps in Section
Workgroup Configuration.

3) Replace the demo license file, zCroDemao.lic, located in the
...\Perceptive\Components\Cairo folder, with a valid license file corresponding to the serial
number of your supplied hardware key. Perceptive Intelligent Capture license file hames
are usually in the format *_xxxxxxxx.lic: where * can be any number of alphanumeric
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characters and xxxxxxxx is an eight-digit number representing the serial number printed on
the corresponding dongle.

4) Configure the RTS Remote Administration MMC snap-in by following the steps in Section
with one exception: In Step 6 of
the procedure outlined, type LocalHost instead of the server name.

5) Configure project settings and test the instance created in step 4 above. You should (at a
minimum) test the OCR, Classification, and Extraction workflow steps. For more
information on how to configure project settings for a Perceptive Intelligent Capture RTS
instance, see the Perceptive Intelligent Capture Runtime Server User’s Guide.

The installation was successful if Perceptive Intelligent Capture runs without errors.
To check for the correct installation of components:

1) Open the installation directory.

2) Open \Components\Tools.

3) Run SCBLibVersion.exe.

4) From the menu, select View>Components General Info. This displays a list of installed
components:

5) Check the list for
- Completeness of components
- Homogeneity of build numbers
- Installation paths

6) All components Cro*.dll, Cdr*.dll and Bwe*.dll should have been registered automatically
during the installation. If some of them seem to be missing, try to register them manually
via the RegCro.bat, RegCdr.bat and BweReg.bat Windows batch files available in
\Components\Cairo, .\Components\Cedar and the corresponding .\Components\Bwe
directories.

If the automatic registration does not work, try to register manually using the program
regsvr32.exe from the Windows system directory.

If this does not help, create a copy of the components list using the command File>Save to file
in the Perceptive Component Version Info dialog box. Submit an error report, the components
list, and the log files located in the ...\ Perceptive\Perceptive Intelligent Capture\lLogs folder to
Perceptive Customer Support.

After you remove the earlier version of Perceptive Intelligent Capture and install Version 5.5
SP1, project files designed in the earlier version must be converted to Version 5.5 SP1 formats
before they can be used in the new version.

The conversion process is fully automated and is done by Perceptive Intelligent Capture
Designer. To convert Perceptive Intelligent Capture Version 3.0, 4.x or 5.3 project files to
Version 5.5 SP1, do the following:

1) Launch Perceptive Intelligent Capture Designer.

2) On the Load Project dialog box, browse to the project file location and double click on the
project file that you want to convert. Login to the project using Administrator for User 1D
with the corresponding password.

Perceptive Intelligent Capture Page 38 of 127



Installation Guide Chapter 5 Installation

3) Click OK to launch the automatic project conversion process. The conversion takes from a
few seconds to a few minutes, depending on the size of the project.

4) Once the conversion is completed, click Learn (Light bulb) to relearn the project.

5) Save the project. The project is ready for use in Perceptive Intelligent Capture Version 5.5
SP1.

Very Important!
Please note that a project and Learnset backup should always be taken.
See Also

For information on how to configure a project for a Perceptive Intelligent Capture
database, see the Perceptive Intelligent Capture Designer User’s Guide.

5.9 Removing Perceptive Intelligent Capture Version 5.5 SP1

Perceptive Intelligent Capture can be uninstalled by using the Windows Control Panel's Add/
Remove functionality. It is important to stop all running services using the Task Manager
before uninstalling the application. To remove previous versions of Perceptive Intelligent
Capture:

1) Click Start>Settings>Control Panel.

2) Launch the Add/Remove Program wizard.

3) On the Currently Installed Programs list, select Perceptive Intelligent Capture V5.5 SP1.
4) Click Remove.

5) Follow the on-screen instructions. (See below).

Figure 5-20: Removing a Perceptive Intelligent Capture installation

6) After un-installation, reboot your computer.

5.10 Repairing a Perceptive Intelligent Capture Version 5.5 SP1
Installation

The Perceptive Intelligent Capture installer may be used to repair a copy of Perceptive
Intelligent Capture that has stopped working properly. Factors that could cause an installation
to malfunction include:

o Accidental deletion of application files

e Missing registry entries

e Corrupted application files

¢ Malicious attacks on a machine housing Perceptive Intelligent Capture
To repair Perceptive Intelligent Capture:

1) Select Start>Settings>Control Panel.

2) Select Add/Remove Program.
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3) In the Currently Installed Programs list on the Add/Remove Programs dialog box, select
Perceptive Intelligent Capture v5.5 SP1.

4) Click Change.

5) On the Setup dialog box, select Repair then click Next. (See below) This will
reinstall all program components which were installed by the previous setup.

Figure 5-21: Repair an existing Perceptive Intelligent Capture installation

6) Click Finish when setup is completed.

5.11 Adding or Removing Version 5.5 SP1 Components
Perceptive Intelligent Capture is a product suite consisting of the following applications:
e Perceptive Intelligent Capture Runtime Server

e Perceptive Intelligent Capture Designer

o Perceptive Intelligent Capture Verifier

o Perceptive Intelligent Capture Web Verifier

The Perceptive Intelligent Capture deployment utility, Setup.exe, uses a modular approach
that enables you to add or remove applications from a machine.

To modify an existing Perceptive Intelligent Capture installation:

1) Select Start>Settings>Control Panel.

2) Select Add/Remove Program.

3) Inthe Currently Installed Programs list, select Perceptive Intelligent Capture V 5.5 SP1.
4) Click Change.

5) On the Setup dialog box, select Modify and click Next. (See below)
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Figure 5-22: Modifying a Perceptive Intelligent Capture installation

6) Inthe Select Components dialog box, select or clear the desired components.
7) Click Next. Setup adds (if checked) or removes (if unchecked) the components.
8) Click Finish when setup completes.

5.12 Installing Perceptive Intelligent Capture Service Packs /
Service Updates

Interim updates, minor enhancements, and defect corrections for
Perceptive Intelligent Capture are typically released as a service pack. Service Packs for
Perceptive Intelligent Capture are self-extracting executables. Perceptive distributes them in a
number of ways, including e-mail and product CDs.

A Release Notes document detailing the product issues addressed and deployment
instructions specific to that service pack accompanies each Service Pack release.

Generally, you can install the Perceptive Intelligent Capture service packs as follows:
1) On the Windows Desktop, click Start = Run.

2) Browse to the location of the Service Pack executable.

3) Double click on the executable.

4) Follow the on-screen instructions.

Note: After installation of a service pack, launch the Register Web Server.bat in the
Perceptive Intelligent Capture Web Server\Bin folder and run the CdrReg.bat in the
Perceptive Intelligent Capture\Components\Cedar folder in order to register all of the new
components. Only then, you will be able to open batches in Web Verifier.
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The following steps are to be followed:

- Backup your project data before application of Service Updates or patches to your
system.

- Backup the configuration of your 1IS. To do this, open the IS Manager under Control
Panel > Administration Tools - Internet Information Services, right click on your local
machine, and then select All Tasks and Backup/Restore Configuration.

- Before installation of a new patch, all RTS instances have to be stopped and all of the
Perceptive Intelligent Capture applications have to be exited.

- After installation of a Web Verifier patch or Service Update, restart 11S. To do this, open
the 1IS Manager, right click on your local machine, go to All Tasks, and then click on
Restart IIS.

- Perform standard sanity testing procedures.

5.12.1. Current patch level

If you want to check for the current version of the combined patch you are using, do the
following:

1.  Check the file version for the “Brainware.Verifier.WebClient.dll” in \Perceptive Intelligent
Capture\bin directory.

2. Check the highest file version of the “Cdr™*.dIlI” in \Components\Cedar and “Dst*.dll/exe
in \Perceptive Intelligent Capture\bin.

The highest of the version number is the installed patch.

5.13 Password Encryption for Database Connection Strings in Core
Config Files

The application architecture of Perceptive Intelligent Capture makes it very important to be
able to hide sensitive security information, such as DB access password, stored in Perceptive
Intelligent Capture or custom project configuration files.

Password encryption is optional and former configuration files with unencrypted passwords will
still work with no issues.

Below are the steps to encrypt the database connection password for the core Perceptive
Intelligent Capture *.config files:

1. Open one of the Perceptive Intelligent Capture config files you use, for example
MApplication\bin\DstDsr.exe.config in a text editor.

2. Locate the connection string and the password part of the string, example:
<connectionStrings>

<add name="Entities"
connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity.Entities.ssdl|res://*
/Entity_Entities.msl;provider=System.Data.SqlClient;provider connection string=&quot;Data
Source=MYSQLSRV; Initial Catalog=DatabaseName;Integrated Security=false;User ID=alexey;
Password=MyPassword;MultipleActiveResultSets=True&quot;"
providerName="System.Data.EntityClient" />

</connectionStrings>

3.  Modify the password, replacing it with any amount of star signs, example:
<connectionStrings>

<add name="Entities"
connectionString="metadata=res://*/Entity_Entities.csdl|res://*/Entity_Entities.ssdl|res://*
/Entity_Entities.msl;provider=System.Data.SqlClient;provider connection string=&quot;Data
Source=MYSQLSRV; Initial Catalog=DatabaseName;Integrated Security=false;User ID=alexey;
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Password=********-NyltipleActiveResultSets=True&quot;"
providerName="System.Data.EntityClient" />

</connectionStrings>
Note: the number of * is not important.

4. Run the .Perceptive\Perceptive Intelligent Capture\bin\DstCrypt.exe tool with the following
arguments:

DstCrypt.exe /text "MyPassword" >> my_encrypted_password.txt

b. You could add the line above to a new .bat file created in Perceptive\Perceptive Intelligent
Capture\bin\ directory and double click on it - this should produce a new file with the name
"my_encrypted_password.txt" in the same directory where the executable is located.

5.  Open the resulting text file:

a. It will contain a text like in the example below. Copy its red part that represents the
encrypted password:

Text MyPassword encoded to
Y652CeXVdMtdNtbnBD2 1 tCEmFFFYHTI1GsN2psi6svy/MsKp8nKUgv2P7M37uu5rNo3V7wkH5795A5z6WGox/KEm60 I
6AGITIX+B5mi0Qg710gJCBgoHrsAbICHzm2EJIbCkaMploUcvtP+8hpeJVMIBpD+QKFL I i thUXINhWaCM=

6. Locate the "appSettings" section of your DstDsr.exe.config file and add the new
"EncrPwd" key to this section, assigning the red encrypted sequence above to the value
of the key. Example:

<appSettings>

<add key="EncrPwd"
Y652CeXVdMtdNtbnBD2 1 tCEmFFFYHTI1GsN2psi6svy/MsKp8nKUgv2P7M37uu5rNo3V7wkH5795A5z6WGox/KEm60 I
6AGITIX+B5mi0Qg710gJCBgoHrsAbICHzm2EJIbCkaMploUcvtP+8hpeJVMIBpD+QkFL I i thUXINhWaCM=

</appSettings>
Save your DstDsr.exe.config file.

When required, apply steps 1-7 to the other core configuration files, that represent
different applications. These are:

For Runtime Server application: \Application\bin\DstHost.exe.config
For Learnset Manager tool: \Application\bin\DstSIm.exe.config

For Designer application: \Application\bin\DstDsr.exe.config

For Thick Verifier application: .\Application\bin\DstVer.exe.config

® 2 0o T o

For supervised learning nomination feature of Web Verifier application:
MApplication\bin\Brainware.System.Project.exe.config

f.  For Web Verifier application: \Application Web Server\web.config

Note: corrupted or incorrect encryption key or an incorrect password in the web.config file
will entail the following error message when trying to open the Web Verifier application:

Figure 5-23: Error message associated with incorrect encryption key/password
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5.14 INI File Encryption

Perceptive Intelligent Capture allows the user to encrypt a password within the open text INI
file. For example, for database connections (Reporting, PO Lookup), SAP connections
(Export), etc. RSA encryption is used which contains a public key and a private key.

Public Key: provides customer or PS integrated, for user who wants to encrypt text in INI file. It
is distributed to PS teams and customer service for generating an encrypted passwords.

Example:
<RSAKeyValue><Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHE10750cpTUEZLPK6 i z6bHA0dPVgLFaOEK+XMMS2G5z+696
1vuQsDGUt+01Ag1Pi TXCa6rrAaeCaabDO4H 1 8MmpwOOKUZEFCZpTTYCYQPFZIgokwomF6VDSBOd 1US4301TOgctQY1b5iM4aM
qT0=</Modulus><Exponent>AQAB</Exponent></RSAKeyValue>

Private Key: held by project owner/ developer only.

Example:
<RSAKe5VaIue><ModuIus>vJ+W7SuXqurWVoy4tPrbfLCuoHEIo7SOcpTuEzLPk6iszHAodPVgLFaOEK+XMMSZGSz+696
1vuQsDGUt+01Ag1Pi TXCa6rrAaeCaabD0O4H 1 8MmpwOOKUZEFCZpTTYCYQPFZIgokwomF6VDSBId 1US4301TOgctQY1b5iM4aM
qT0=</Modulus><Exponent>AQAB</Exponent><P>8SRHEVT5Bn2paRHSDRYYyCQb7WGYE9PbeHzuqwH6 iWaOLNYJrSrhhU
eCEpwIPLQWQq10KmMMZgGO+Br4nuBMmMHQ==</P><Q>yD719fjB/MIWYaV3LcEzY286Q+Xvo74i6 THVHKKB1NKYGCNIXF9Id
8Xbi1UQNgBZ/4F02T6mFeYDO32KFVRXH0Q==</Q><DP>nRDTFn7nwRmSgfRwi8minkyk5DQ3 1FO35E 1 Z+x3A04Z52ZWkStwD
26/c12vR3XJIVQg7irkUONBIzoDK1bklSw5Q==</DP><DQ>B3xi1eGmORva05/2ZkPpSA3ubAALOjJI6FC5a0S7t0Q+vXMFdoTD
457 1sTA+ipY Ip2yVpyt1l0tC7FHBA7Y0S95Q0==</DQ><InverseQ>4S1xqIXK9f1lrawGCbFWOVp61z1fCoQ8RFyDE87/G/p
Ui IHRJV2acBAcngY3c/MRMKIrXQb8I1x99k7dENUYc8ywQ==</ InverseQ><D>KAL6cwkCQKgbuvKFRNSLZmFOqV2JpB5k1/p
1U+0GWAs6Q14wnPqy+5303nala2faPctXLSKJIqvIvSz21VDMUCsyphvOSxBtclcZHIp4ueQPA7u+qri1JaDY1RhIAVogNTfCJ
FX6+McVJ+1/X+mZ0CtdUaCuAoNn014UYOaMujYDQE

=</D></RSAKeyValue>

Below is the new connection string parameter:

SQL_VL_01_ConnectionString=Provider=SQLOLEDB.1;Persist Security Info=True;User ID=sa;Initial
Catalog=MyData;Data Source=10.4.0.19

SQL_VL_01_ConnectionPassword=MyEncryptedPassword
5.14.1. INI File Encryption for Project Developer

The idea of coding is to locate the code that calls Database Connection from the INI file, so
that you can read the new line in the INI file with an encrypted line text. The password then
can be decrypted by using a Private Key. At last, you append the password to the end of the
Connection String in the INI file.

As a project developer, you can select the CdrCrypt ScriptModule in the Reference section of
Project File Script Page.

|

References - ScriptModule

Awallable References:

[ Cairo Flec:ognita OCR [1.0 ! N oK
]
[] CdEneryptionProvider [1.0)

Pl

C |
[ CHdsn 1.0 Type Library (1.0] — anee
[]CdivwéH 1.0 Type Library (1.0)
[ Cedar Address &nalysis | Libram [1.0] ﬂ Help
[[]Cedar Address Analpsis || Library [1.0)

Figure 5-24: Script Module References
Note: Additional security can be provided by Encrypting Script Page.

Example script of the encrypted password:
Dim theCedarCryptographyHelper As New CdrCrypt.RSACodeclint
Dim strEncryptedPassword As String
Dim strOpenPassword As String
Dim strPrivateKey As String

strPrivateKey =
"'<RSAKeyValue><Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHEl0750cpTuEzLPk6 i z6bHAOdPVgLFaOEK+XMMS2G5z+69
61vuQsDGUt+01AglPiTXCabrrAaeCaaDO4H 18MmpwOOKUZEFCZpTTYCYQPFZIgokwomF6VYDSBOdIUS4301TOgctQY1b5iM4
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MgTO=</Modu lus><Exponent>AQAB</Exponent><P>8SRHEVT5Bn2paRHSDRIYyCQb7WGYE9PbeHzuqwH6 iWaOLNYJrSrhh
UeCEpwIPLQWQQq10KMMZgGO+Br4nuBMmMHQ==</P><Q>yD7 19f jB/MIWYaV3LCcEzY286Q+Xv074i6THVHKkKgBINKYGCNIXF9
d8XbiUQNgBZ/4F02T6mFeYDO32KFVRXH0Q==</Q><DP>nRDTFn7nwRmMSgTRwi8minkyk5DQ3 1FO35E 1Z+x3A04Z52ZWkStw
Dz6/c12vR3XJIVQ7irkUONBIzoDK1bk I Sw5Q==</DP><DQ>B3xieGmORva05/2ZkPpSA3ubAALOjJ6FC5a0S7t0Q+vXMFdoT
D45J1sTA+ipY 1p2yVpytl1l0tC7THBA7Y0S95QQ==</DQ><InverseQ>4S1xqlXK9FflrawGCbFWOVp61z1FfCoQ8RFyDE87/G/
pUi IHRJV2acBAcngY3c/MRMKIrXQb81x99k7dENUYc8ywQ==</InverseQ><D>KAL6cwkCQKgbuvKFRNSLZmFOqV2JpB5k1/
p1lU+0GWAs6Qi4wnPgy+5303nala2faPctXLSKJIqvIvSz21VDMUCsyphvOSxBtclcZHIp4ueQPA7u+qriJaDY1RhIAVogNTC
JFX6+McVJI+1/X+mZ0CtdUaCuAoNn014UYOaMujYDQE=</D></RSAKeyValue>*

strEncryptedPassword = DicvVal(*'01" & "‘ConnectionPassword™, *'SQL™)
IT Len(strEncryptedPassword) > O Then
strOpenPassword = theCedarCryptographyHelper.Decode(strEncryptedPassword, strPrivateKey)
End If
IT Len(strOpenPassword) > 0 Then
strConnection = strConnection + *;Password=" + strOpenPassword

End If
5.14.2. INI File Encryption for Integrator

As an integrator, you simply need to add the encrypted customer password, and encrypt the
password similarly to Config files.

Run the following command in the Perceptive\Perceptive Intelligent Capture\bin folder:

DstCrypt.exe /text “MyPassword"™ /key
""<RSAKeyValue><Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHE10750cpTuEzLPk61z6bHAOAPVgLFaOEK+XMMS2G52+69
61vuQsDGUt+01Ag1PiTXCa6rrAaeCaabD04H 1 8MmpwOOKUZEFCZpTTYCYQPFZIgokwomF6VDSBId1US4301TOgctQY1b5iM4
MgTO=</Modulus><Exponent>AQAB</Exponent></RSAKeyValue>" >> my encrypted_custom password.txt
The my_encrypted_custom_password.txt will now contain the encrypted text string for the

password.

And then, add the encrypted password to the ConnectionPassword INI tag.

SQL_VL_01_ConnectionPassword=puejB5SQNCFGgwe6MRoWc1G1ly7gX8xSAhgUZjhN6JolhYdKIxIa7vLMU4bYmGOV3Ay
xualp/ObgXRgnSAMGSGF1FPZXktRmF58SXbnCDXmYrYgp8eS3laqiLUPrhTiRCvFr8ZsMtK+3usmahfxpESUOQ7MZF36suW
V4V3sBFIOXw=

5.15 Silent Installations

A Silent Install mode is provided for situations where the same configuration of Perceptive
Intelligent Capture is to be installed on several machines, for example, Verifier workstations.
The use of a configuration file removes the necessity to go through the installation dialog on
each machine.

5.15.1. Silent Install.ini

The configuration settings for the silent installation are read from the “Silent Install.ini” file in
the Perceptive Intelligent Capture installation directory. The directory contains an example file
which must be edited before performing a silent installation.

The file contains seven sections — General, Applications, OCR Engines, Additional,
AutoServiceUpdate, Database Configuration, and DB Credentials.

It's allowed to delete single entries or complete sections.
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However, it's not allowed to use options without the section name. If any information is deleted
from the "Silent Install.ini" file, the Setup uses the DEFAULT values as described.

Name Description

[General]

Determines how and where Perceptive Intelligent Capture is to be installed.

Path =

Indicates where the application should be installed. The pathname should not
have a final backslash.

Example: Path = C:\Program Files\your company name.

MoveComponentsIfRequired =

If an older version of the application is installed, this indicates whether to use
the existing component folder or whether to move the old components into the
new directory prior to installation.

0: Use existing component folder.

1: Move components to the new path.

CreateDeskToplcons =

0: Don'’t create desktop shortcuts.

1: Create desktop shortcuts.

InstallWibuKey =

0: Skip Wibukey driver installation.
1: Install Wibukey drivers.

StoplfDotNetlsNotFound = #

0: If .Net Framework 3.5 SP1 is not found on the system the installation
proceeds.

The Features (WebVerifier, Database Connection...) will not be installed.

1 (DEFAULT): If .Net Framework 3.5 SP1 is not found on the system the
installation will be aborted.

[Applications]

Defines which applications are to be installed.

Note that it is permissible to skip all applications if, for example, only the
extraction components are to be installed.

Designer = 0: Skip installation of the Designer application.
1: Install the Designer application.
Verifier = 0: Skip installation of the Verifier application.

1: Install the Verifier application.

Runtime Service =

0: Skip installation of the Runtime Server application.

1: Install the Runtime Server application.

Web Verifier=

0: To skip installation of WebVerifier application (Thin Client)

1 (DEFAULT): Install WebVerifier application (See also option
StoplfDotNetlsNotFound)

[OCR Engines]

Defines which OCR engines are to be installed. It is permissible to skip all the
engines.

FineReader8.1 =

0: Skip installation of ABBYY FineReader 8.1.

Perceptive Intelligent Capture
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Name Description

1: Install ABBYY FineReader 8.1.

FineReader10 = 0: Skip installation of ABBYY FineReader 10.
1: Install ABBYY FineReader 10.

Kadmos5 = 0: Skip installation of Kadmos 5 engine.

1: Install Kadmos 5 engine.

Recognita = 0: Skip installation of Recognita engine.

1: Install Recognita engine.

QualitySoft 0: Skip installation of QualitySoft engine.
1: Install QualitySoft engine.

Clegs = 0: Skip installation of Clegs engine.

1: Install Clegs engine.

[Additional] Additional files to install.

Demo Files = 0: Skip installation of the demo project files.

1: Install demo project files.

[AutoServiceUpdate] Defines the installation of automatic ServiceUpdate (will be skipped if
ForDesigner and ForVerifier are skipped)

ForDesigner = 0 (DEFAULT): Skip definition of ServiceUpdate for Designer Application.

1: Defines Shortcut for Designer start with automatic ServiceUpdate

ForVerifier = # 0 (DEFAULT): Skip definition of ServiceUpdate for Verifier Application.

1: Defines Shortcut for Verifier start with automatic ServiceUpdate.

NetworkUpdateFolder = "*" Path where automatic ServiceUpdate looks for Updates.
(DEFAULT empty string)

[Database Configuration] Configures Existing DatabaseServer (See also option
StoplfDotNetIsNotFound).

DBServerType = # 1: SQL Server database will be configured.
2: Oracle Server database will be configured.

3 (DEFAULT): No database will be configured.

If there is any wrong information for the following options DBServerType will be set to 3

UseDBConflniFile = "*" Text file name that contains Database Connection String.
If this option is empty, credentials will be taken from [DB Credentials] section.

If there is neither a config file nor a [DB Credentials] section, DBServerType
will be set to 3 (no database) internally.

(DEFAULT empty string).
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Name Description

[DB Credentials]

This section can be used instead of a config file (See Option
UseDBConflniFile).

(DEFAULT database cofiguration will be skipped, if option UseDBConflniFile is

not set).

Only for SQL Server Usage (See Option DBServerType and UseDBConfiniFile)

SQLServerWindowsAuthent =

0 (DEFAULT): No Windows Authentication will be used for DBA.

1: Windows Authentification will be used for DBA.

SQSglerverAdminUser = "**

DBA account name (See also option SQLServerWindowsAuthent)

(DEFAULT empty string).

SQLServerAdminPassword =

Hgn

DBA account password (See also option SQLServerWindowsAuthent)
(DEFAULT empty string).

For both Database Server Types (See Option DBServerType and UseDBConflniFile)

DBUserWindowsAuthent = #

0 (DEFAULT): No Windows Authentication will be used for DB user.

1: Windows Authentification will be used for DB user.

DBUserName = "*"

DB user account name (See also option DBUserWindowsAuthent)

(DEFAULT empty string).

DBUserPassword = "*"

DB user account password (See also option DBUserWindowsAuthent)
(DEFAULT empty string).

DatabaseServerPath = "*"

Name of the database. Ususal it is build like
<MachineName>\<InstanceName>

(DEFAULT empty string).

Table 5-2: Options for "silent install.ini"

An example "Silent Install.ini" INI-file is available in the root setup directory.

Example:

[General]

Path = C:\Programme\Document Processing Services

MoveComponentslfRequired =
CreateDeskToplcons = 1
InstallWibuKey = 1
StoplfDotNetlsNotFound = 1
[Applications]

Designer = 1

Verifier = 1

Runtime Service =1

Web Verifier= 1

[OCR Engines]
FineReader8.1 = 1
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FineReaderl0 = 1

Kadmos = 0

Kadmos5 = 1

Recognita = 1

Clegs = 1

[Additional]

Demo Files =1

[AutoServiceUpdate]

ForDesigner = 0

ForVerifier = 0

NetworkUpdateFolder = '"\\YourNetworklInstallServerName\YourlnstallShareName"
[Database Configuration]

DBServerType = 3

UseDBConflIniFile = "Your config file name"
[DB Credentials]
SQLServerWindowsAuthent = 0
SQSglerverAdminUser = ""DBA name"
SQLServerAdminPassword = "'DBA password"
DBUserWindowsAuthent = 0

DBUserName = "DB user name'"
DBUserPassword = "DB user password"

DatabaseServerPath = DB Server Machine Name\DB Server Instance Name"

5.15.2. Automated Distribution of Service Updates on Verifier Workstations

Silent Installation can also be used to install service packs and service updates automatically
on Verifier workstations when updates become available in a pre-defined network folder by
running a batch file with the following content:

Call “Silently Install Latest Service Update.bat”
Call “C:\Program Files\ [WL SCN]\ [WL PN]\DstVer.exe”

5.16 Preparing Internet Information Server (post install)

One of the preconditions for working with Perceptive Intelligent Capture Web Verifier is the
installation of the Internet Information Server. Windows 2003 Server works with IS 6.0,
Windows 2008 Server with IIS 7.0.

Perform the installation of the appropriate IS application version. Please use the following
links for more information:

e For Windows 2003 Server and 1I1S 6.0

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/11S/750d3137-
462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true

e For Windows Server 2008 or Windows Server 2008 R2 and IIS 7.0/1IS 7.5

http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-
2008-r2/

5.16.1. Configuring IIS 6.0

The Internet Information Server is used for executing the Perceptive Intelligent Capture Web-
Verifier. The IIS configuration is presented below.
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e Run IIS manager (Start -> Control Panel -> Administrative tools — Internet Information

Services)

e Extend Web Sites.

¢ Right click on Default Web Site node, then choose New->Virtual Directory

t Internet Information Services (II5) Manager

¥3 File  Action  Wiew

Window  Help

- | OEXEFDR @@ 2] mu

Mew ‘Window From Here

‘irkual Directory (From File). ..

Server Extensions 2002 Web

Delete
Rename
Refresh
Export Lisk,..

Server Extensions 2002 Adminiskrator

Properties

Help

Figure 5-25: 11S 6.0 manager

¢ In the dialog window click Next.

¥irtual Directory Creation Wizard
Welcome to the Virtual
Directory Creation Wizard

To continue, click Mext.

Thiz wizard helps vou create a new wirtual director on this
Web zite,

P_'J Internet Information Services [anne | Path
= | QATESTEOXS? {local computer) g _ti_bin C:\Program Files\Comman FilesiMicr ..
- Application Pools ) aspnet_client
=) gab Sites Jimages
5 @
g _vti_bin Explore
) aspnet_clie  SPen
[ images Permissions
) _private Erovise i
---_'_J _vt?_cnf Start
[ _wti_log Stop !
) _whi_pet ll
_,_J _wki_script IFEpEE gif
B vt * web e ..
D"g Microsaft Shar =) Tasks ¥ ‘Web Site (From filg). ..
[+#-__| Web Service Exter : irkual Directory..,
iew

¢ Back I et > I

Cancel
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Figure 5-26: Virtual Directory Creation Wizard
e Type in the Alias you want to use to gain access to this Web virtual directory. Click Next.

¥irtual Directory Creation Wizard

VYirtual Directory Alas
Specify a zhort name, or alias, for thiz virtual director.

Type the aliaz you want to use to gain access to this Web virtual directory. Uze the
£ame haming conventions that you would for naming a directary.

Aliaz:
e erifier

< Back I Mext > I Cancel

Figure 5-27: Alias for the Web virtual directory

e Select the path to the directory with the installed Perceptive Intelligent Capture Web Server
and click Next.

Yirtual Directory Creation Wizard | x| |

Web Site Content Directory
Where iz the content wou want ta publizh an the Web site?

Erter the path to the directary that contains the content for thiz Web site.

Path:

C:AProgram Filesh “Wweb Server Browse. .. |

< Back

Caricel |

Figure 5-28: Path for the Web Site Content Directory

e Set the permissions as shown in the screenshot below. Click Next.
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¥irtual Directory Creation Wizard

Yirtual Directory Access Permizsions
Set the access permizsions for this virtwal directony.

Allaw the fallowing permiszions:

¥ Read

¥ Fiun scripts [such az A5P)

[T Execute [such as |1S4P| applications or CGI]
[ wiite

[ Browse

To complete the wizard. click Next _

¢ Back I Mest » I Cancel

Figure 5-29: Virtual Directory Access Permissions

e Press Finish.

¢ Right click on the Web Verifier node then select Properties.

¢ In the dialog window, open the ASP.NET tab.

e Check the ASP.net version. If it is not a v.2.0 — set it to v.2.0.

Web¥erifier Properties H

Wirkual Direckory I Documents I Directory Securiby |
HTTP Headers I Cuskarm Errors ASP.MET

ASP.MET wersion: I2.EI.5EI?2? j
Virtual path: I Jteberifier
File location: I C:'\Program Filesh mel o
File creation date: I Bf2212012 5:28:17 AM
File last modified: I SJE2J2012 8:31:15 AM

Edit Configuration. .. I

Ok Cancel Apply | Help |
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Figure 5-30: Setting the ASP.net version number

e Select the Documents tab. Remove all default content pages, and add Login.aspx to the

list.
wWeb¥erifier Properties 7| x|
HTTP Headers | Cuskom Errors I A5P . MNET
Yirtual Direckory Docurments | Cireckary Security

—Iv Enable default content page

Rermowve

i

Mewe U e Do |

—1 Enable document Footer

append an HTML Farmatted Fooker ko every document yaur Web
SErver returns.

I Erawse,, ., |

I Cancel apply Help

Figure 5-31: Documents tab — setting Login.aspx as default content page
e Click OK.

e The Perceptive Intelligent Capture Web Verifier application will be accessible by the address
http://localhost/WebVerifier/login.aspx

5.16.2. Configuring lIS 7.0

e Run IS Server Manager (Start -> Administrative tools — Server Manager)
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Figure 5-32: Server Manager

e Extend the Roles directory.

Figure 5-33: Server Roles
¢ Click Add Roles.

e Select Web Server.
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Figure 5-34: Selecting Roles
¢ You will be asked to install other required features.

Add Roles Wizard x|

-."": Add features required for Web Server (lIS)?

- y_—
You cannot install Web Server {115) unless the required features are also installed.
Features: Description:
=1 Windows Process Activation Service \Windows Process Activation Service

generalizes the 115 process model, removing
; ) the dependency on HTTP. All the features of
Corfiguration AFls 1S that were previously available only to
HTTF applications are now available to
applications hosting Windows
Communication Foundation (WCF) services,
using non-HT TP protocols. [15 7.0 also uses
Windows Process Activation Service for
message-based activation over HTTP.

Process Model

|_&.dd Required Features I Cancel |

@ Why are these features required ? Y

Figure 5-35: Additional features required
e Click Add Required Features.

¢ Now you will be able to select the Server Roles.
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Figure 5-36: Selecting Server Roles
e Click Next.

Add Roles Wizard |
Web Server (IIS)
Before You Begin Introduction to Web Server (IIS)
Server Roles Web servers are computers that have spedific software that allows them to accept requests from dient

computers and return responses to those requests, Web servers let you share information over the Internet, or
) through intranets and extranets. The Web Server role indudes Internet Information Services (I15) 7.0, a unified

K Web platform that integrates IIS 7.0, ASP.MET, and Windows Communication Foundation. IIS 7.0 also features
Role Services enhanced security, simplified diagnostics, and delegated administration.

Confirmation

Things to Note
Progress i Using Windows System Resource Manager (WSRM) can help ensure equitable servidng of Web server
Results traffic espedally when there are multiple roles on this computer,

The default installation for the Web Server (IIS) role indudes the installation of role services that enable
you to serve static content, make minor customizations (such as default documents and HTTP errors),
monitor and log server activity, and configure static content compression.

Additional Information

Overview of Web Server (TIS)

Overview of Available Role Services in I1S 7.0
1S Cheddists

Common Administrative Tasks in 115
Overview of WSRM

< Previous | Mext = I Install Cancel

Figure 5-37: Web Server View
e Continue by clicking Next

e Select the Role Services as follows:
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Figure 5-38: Select Role Services

e If you try to install ASP.NET, you will be asked to add additional services and features.

e Add required role services and features by selecting on the appropriate buttons.

Add Roles Wizard x|

-u"l‘: Add role services and features required for ASP.NET?

W

You cannot install ASP.MET unless the required role services and features are also installed.

Role Services: Description:
= Web Server (IIS) wleb Server (11S) provides a reliable,
B Web Server manageable, and scalable \Web application
infrastructure.

= Application Development
ISAP| BExdensions
ISAP| Fitters
NET Edensibility
= Windows Process Activation Service
MET Environment

[ add Required Role Servicss | Cancel |

@ Why are these role services and features required?
4

Figure 5-39: Adding role services and features required

e Now you will be able to complete the selection.
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Figure 5-40: Complete selection for role services
e Confirm by clicking Next.

¢ Now click Confirmation.

Figure 5-41: “Confirmation™ view

¢ Click Install to install the selected roles, role services, and features.
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Figure 5-42: “Install’” view

¢ Check the Result overview and finish by clicking on Close.

Figure 5-43: “Result” view

¢ Repeat the steps for the installation of the Application Server.
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Figure 5-44: *“Add Roles” for Application Server

o After installation of the required additional roles and features, the Result view will be the
following:

Figure 5-45: Final Result view

e Check the Roles view again.
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Figure 5-46: Final Result view

¢ Now run IIS manager (Start -> Administrative tools — Internet Information Services (11S)
Manager)

Figure 5-47: 11S Manager

¢ Right click Default Web Site.
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Figure 5-48: Default Web Site menu

e Select the Add Application menu item.

¢ In the dialog window, enter the Alias you want to use to gain access to this Web virtual
directory. Set the Physical path to the directory with the installed Perceptive Intelligent

Capture Web Server and then click OK.

Add Application H |

Site name;  Defaulk Web Site

Path; !
alias; Application pool:
I'u'u'el:u'u'erifier IDeFauItAppPDDI Select, .. |

Example: sales

Pheysical path:

IC:'I,F‘ru:ugram Files (=360 E

Pass-through authentication

Connect as... Tesk Setkings. ..

Ik

Cancel

Figure 5-49: Settings for Alias and the physical path

e Double click the Default Document icon.
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Figure 5-50: Setting the Default Document |
e Click Add.

Figure 5-51: Setting the Default Document I1
e Add Login.aspx to the list.
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Figure 5-52: Adding default document

e The Perceptive Intelligent Capture Web Verifier application will be accessible by the address
http://localhost/WebVerifier/login.aspx .

5.16.3. Windows 2008 and above

Disable DEP with following command:

* bcdedit.exe /set {current} nx AlwaysOff

Note: The server must be rebooted after this command has been applied.

5.16.4. Windows 2008 64bit R2

The following steps are required in order to configure 1S 7.5 for your operating system:

1. Create an application pool or change defaultAppPool with the following advanced
properties:
* Enable 32-bit applications = True
* Managed pipeline mode = Integrated
* |dentity is set to NetworkService

2. Assign the Web Verifier application to this application pool so that the application can run
under 32-bit mode.

3. Disable DEP with following command:
* bcdedit.exe /set {current} nx AlwaysOff

Note: The server must be rebooted after this command has been applied.
5.16.5. Enabling HTTP Compression on your Windows 2003 Server

To more efficiently use available bandwidth, enable [IS HTTP compression. HTTP
compression provides faster transmission time between compression-enabled browsers and
IIS. HTTP compression allows faster page serving to clients and lower server costs due to
lowered bandwidth.

¢ Open up lIS and right click on Web Sites node, and go to Properties.

e Go to Service tab. (See figure below)
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eb sites Properties i s
Web Site I Performance I ISAPI Filters I Home Directory I Documents |
Directory Security I HTTFP Headers I Custom Errors Service

—Isolation mode

[ Run W service in 115 5.0 isolation mode

—HTTP compression
¥ Compress application files

¥ Compress static files

Temnporary direckory: | Swindie¥) 115 Temparary Compress Browse, ., |

Maximum kemporary directory size;

& nlimiked

™ Limited ko {in megabytes): I a5

QI I Cancel Ay Help

Figure 5-53: The Web Sites Properties dialog box

e Set up values as shown in figure above.

Compress application files: Check this to compress application files. It works only if you have
Compress static files checked.

Compress static files: Check this to compress static files. Selecting this option will activate the
Temporary directory text box.

Temporary directory: You can leave this at the default, which is %windir%\IIS Temporary
Compressed Files, or set it to a custom folder. This is where temporary compressed static files
will be stored.

Maximum temporary directory size: This option enables you to set the maximum size of the
temporary directory. Once the size limit is reached, newly added files will replace the oldest
files.

¢ Next, go to Web Service Extensions. Right click on the right panel, and then click Add a
new Web service extension. You can enter any name for the extension, but HTTP
Compression is recommended.
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New Web Service Extension

Tvpe the name of the new Web service extension, and specify the files that
st be enabled For the extension ko run.

Extension name:

i HTTP Compression

Required files:
C M TMDOWS, sy skem 32Yinet s gzip. dil

add. ..
Remove |

Iv Set extension status to Allowed:

| Ik l Zancel Help

Figure 5-54: Web Service Extension dialog box

Click Add..., Choose C:\WINDOWS\system32\inetsrv\gzip.dll, and then click OK.
e Check Set extension status to Allowed box, and then click OK.

5.16.6. IIS 6.0 Metabase Configuration - MetaBase.xml

e Open Windows Explorer and go to C:\Windows\System32\inetsrv.

¢ Find MetaBase.xml and make a backup copy.

¢ Now open up MetaBase.xml in a text editor. Find the <llsCompressionScheme/> section.
Be careful, there are two sections here: one for deflate and one for gzip. Select the section
for gzip. (See ) The Location attribute of this element will have the following
value:
Location ="/LM/W3SVC/Filters/Compression/gzip". Look for the HcScriptFileExtensions
section. As default, it should contain: asp, dll, and exe. This is where you add any
extensions you want to be compressed for dynamic files. For instance, you can add the
extension aspx.

Note: Use a list format for the file extensions as in the sample below using a new line for
each extension and indenting them using tabs.
For Web-Verifier this section should look as follows:
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<IIsCompressionschemea

HoCreateFlags="1"
HcDoDynamicCompression="TRUE"
HcDoonDemandCompression="TRUE
HchostaticCompression="TRUE"
HcDynamicCompressionLevel="10"
HcFileExtensions="htm

htm]

txt"
HconDemandcumpLeveT:“lO“
HoPriority="1"
HcscriptFileExtensions="asp

exe
aspx
astx
is

axd"

=3
</IIsCompressionschemes

Figure 5-55: MetaBase.xml

Location ="/ /M w3svi Filters Compressiony
HoCompressionD]1="%windir¥system32hinetsrviazip.

e Save this document by opening IIS and right click on the top node, Internet Information

Services, and then check Enable Direct Metabase Edit.

e The final step is to exit IIS and to restart by right clicking Internet Information Services node,
and then click All Tasks, Restart IIS.
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Chapter 6 Configuring Application
6.1 Configuring Application

There are some main configuration parameters to be accounted for. See for more
information.

6.1.1. Configuring Perceptive Intelligent Capture Database connection string

e Open the application configuration file (Perceptive Intelligent Capture Web
Server\web.config)

¢ Find the following string:
<connectionStrings>

<add name="Entities"
connectionString="metadata=res://*/Entity_Entites.csdl|res://*/Entity_Entites.ssdl|res://*/En
tity.Entites.msl;provider=System.Data.SqlClient;provider connection string=&quot;Data
Source=NEO\SQLSERVER2005; Initial Catalog=Perceptive_verifier_work; Integrated
Security=false;User ID=developer; Password=123456;MultipleActiveResultSets=True&quot;"
providerName="System.Data.EntityClient" />

e Modify the connection string in accordance with your database settings.

e Replace the connection string within the Brainware.System.Project.exe config file by the
one configured within the web.config file.

Note: These two connection string entries must be identical in order to assure the
availability of all Web Verifier functionalities associated with the Knowledge base.

6.1.2. Setting path to license file

e Open the application configuration file (Perceptive\Perceptive Intelligent Capture Web
Server\web.config)

¢ Find the following string:
<project.controller>
<project licensePath="{app_root}\License\Runtime.lic" ...

</project._controller>
¢ Modify the licensePath value in accordance with the location of your license file.
6.1.3. Enable HTTP compression for IIS 6.0 and IIS 7.0

In order to enhance your application performance and to save server costs, it is recommended
you enable HTTP compression in the context of the Internet Information Services.

Please use the following links for detailed information.
For 11S 6.0:

http://www.microsoft.com/technet/prodtechnol/\WindowsServer2003/Library/11S/d52ff289-94d3-
4085-bcde-24eb4f312e0e.mspx?mir=true

For 11IS 7.0:

http://technet.microsoft.com/en-us/library/cc771003.aspx

6.2 Server Security Configuration
6.2.1. Registering COM components

After applying a patch, locate and run the 'Register Web Server.bat' as administrator. It is
located in the Perceptive Intelligent Capture Web Server\bin\ folder. For registering this
component:
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¢ Right click on the Register Web Server.bat file.

¢ Select Open from the context menu.

It is necessary for the user of the user context in which the Web Verifier is running in 1IS to
have the proper rights to access the SQL Server database. By default, the Web Verifier runs
under the NETWORK SERVICE user context, hence the same should be allowed to access
the database.

If you select Windows Authentication during the installation of Perceptive Intelligent Capture,
you will need to add the domain username to the SQL Server 2008 DB additionally to the NT
AUTHORITY\NETWORK SERVICE.

Steps to add Network Services to SQL server:

Open Microsoft SQL Server Management Studio.
Expand the local computer name, select Security > Logins.
Right click Logins, select New Login.

On Login Properties, under General, click Search. Enter NETWORK SERVICE and then
click Check Names. Click OK.

In Login Properties window, under General, select Windows Authentication.

> wnh e

Under Server Roles, select serveradmin and sysadmin (public is selected by default).
Click OK.

Repeat steps 2 — 4 to add the domain username. Click OK to confirm.
Select sysadmin (public is selected by default) for Server Roles. Click OK.
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Figure 6-1: Selecting server roles.
9. The NT AUTHORITY \NETWORK SERVICE has been added to SQL server.

Figure 6-2: Login list
After adding Network Service and domain username to SQL server, make sure that the IIS is
running under NT AUTHORITY \ANETWORK SERVICE by opening the IIS Manager.

To open IIS Manager from Start menu:
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Click Start, and then select Control Panel.
Select Administrative Tools, and then click Internet Information Services (1IS) Manager.

In the Connections panel, expand the server node and click Application Pools.

P w DD

On Application Pools, select the application pool which you want to specify an identity,
and then click Advanced Settings in the Actions panel.

Figure 6-3: Application pools list
5. For the identity property, the built-in account should be NetworkService.

Figure 6-4: Identity.
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6. If it does not contain NetworkService, click Set... to open the Application Pool Identity
dialog box.

Figure 6-5: Application Pool Identity dialog box.
7. Select the Built-in account option and select NetworkService account from the list.
6.2.2. Setting Permissions for Perceptive projects execution

All Perceptive projects are located in a filesystem folder. The Web Verifier sources this path
from the Perceptive Intelligent Capture Database. Perceptive projects are loaded by the
“Brainware.System.Project.exe” process. This process cannot load the projects until it has the
appropriate permissions for the projects folder. In this case, it is necessary to grant permission
to the “Network Service” Windows user for this folder by performing the following steps:

e Select the projects folder.

¢ Right click on the folder and select Properties.

¢ Inthe dialog window, select the Security tab.

e Add the Network service user to the list.

6.2.3. Encrypting sections with aspnet_regiis tool

If you want to protect the data stored in the configuration file perform the following steps:
Pre-configuring:

e Find the “Brainware.System.AppConfiguration.dll” file in the Perceptive Intelligent
Capture\bin\ directory.

o Register this assembly in the GAC using the
gacutil -I Brainware.System.AppConfiguration.dll command.
Encryption of the web.config file:
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e Use the aspnet_regiis command-line tool. This tool is located at:
C:\WINDOWSWIicrosoft. NET\Framework\v2.0.50727\aspnet_regiis.exe

e For encrypting a particular section of the configuration file, you can use the -pe option
when executing the aspnet_regiis tool.

For example, for encryption of the connectionStrings section use:
aspnet_regiis -pe connectionStrings -app/MyApp

Note: The “-app” option is used to specify the application’s virtual path.
Decryption of the web.config file:

o For decryption of a configuration section, use the following command: aspnet_regiis -pd
connectionStrings -app/MyApp

6.3 Client Security Configuration
This section describes security configuration for the client side.

¢ Open your Internet Browser. Select Tools->Internet Options, and then select the Security
tab. Click Custom Level...

Figure 6-6: Internet Browser — Security tab

e Check for the configuration settings (See the screenshots below)
v ActiveX controls and plug-ins:

e Binary and script behaviors setting should be Enable.

e Run ActiveX controls and plug-ins setting should be Enable.

Perceptive Intelligent Capture Page 73 of 127



Installation Guide Chapter 6 Configuring Application

Figure 6-7: Custom level configuration settings — ActiveX controls and plug-ins

v’ Scripting
¢ Active scripting setting should be Enable.

¢ Allow status bar updates via script setting should be Enable.

Note: Only if allowing status bar updating via script is enabled, will the information on
batches, documents, current filters and page number be displayed.
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Figure 6-8: Custom level configuration settings — Scripting

6.4 Configuring Windows Authentication for Web Verifier

The Web Verifier application allows you to login with your Windows user account. In this case,
the password that is shared with Windows will be used to login into Web Verifier.

To use this option, you first need to configure the server.

Note: Only Windows Authentication access will be possible after this option is configured.
However, when logged in to Web Verifier via Windows Authentication, it will be possible to
use the re-login menu option to login e.g. as an administrator in order to perform certain
administrative tasks.

Prerequisites which apply to both, lIS6 and IS 7

- Before starting to configure IIS, make sure that the Web Verifier application is working
properly using an existing project user account.
- Back up the web.config file.

6.4.1. ForllS7
To configure Windows Authentication access to Web Verifier with IIS 7:
1. Open “Authentication” application settings in 1IS group.
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Figure 6-9: Entering Authentication application settings

2. Enable “Windows Authentication” and disable all other authentication methods.

Figure 6-10: Enabling/Disabling authentication methods

3.  Close all of the running browser sessions prior to access the Web Verifier application.
4.  Add the Windows user to the database. Please refer to the Designer User Guide for
information on how to do this.

Note: In IIS 7, Error Pages will be configured automatically.

6.4.2. ForllS6
To configure Windows Authentication to Web Verifier with [1S6:

1.  Open the WVC application properties.
2.  Goto Directory Security tab, Authentication and access control section and
press the Edit button.
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Figure 6-11: Entering the Authentication and access control area

3. In the Authentication methods dialog, enable Integrated Windows Authentication and
disable all other authentication methods
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Figure 6-12: Enabling/Disabling authentication methods

4. In order to enable custom error page for “Not Authorized” status, it is needed to
configure IS to redirect to <Web Verifier Installation Directory>/ErrorPages/401.htm
when 401.x error is received:

- Select WVC application properties.

- Go to Custom Errors tab.

- Select each of the 401;x error code properties one after another.

- When one of the properties selected, press the Edit button.

- In the Edit Custom Error Properties dialog, select File for Message Type.
- Enter path to <Web Verifier Installation Directory>/ErrorPages/401.htm
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'{'_“g File  Action  Wiew  Window BTt B ]l dd (= EHE3

e = | | X wirkual Direckory I Documents | Direckary Security
?'g Tnkernet Information Services HTTP Headers Custorn Errors | ASP.NET

=- 5 IP-DACEHAD (Jocal compu
[#-_J Application Pools

—Error messages for HTTP errors

E|_-J Web Sikes Cuskom error messages can be an absoluke URL on this server or a painker o a
- =4 Default Web Site file.
: G-+ 0 verif

g verier HTTF _ | T_| Contents
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: ‘fJ 400 File i \WINDOWS, helpiisHelp'common’ 400, htr -

“au) Webverifier
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-l Web Service Extensior
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Figure 6-13: Custom Error properties for 401 errors
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Figure 6-14: Editing Custom Error properties

5.  In order to enable custom error page for “Not Found” status it is needed to configure IS
to redirect to <Web Verifier Installation Directory>/ErrorPages/404.htm when 404.x error
is received.

- Select WVC application properties.

- Go to Custom Errors tab.

- Change all 404;x error code properties to point to file
<Web Verifier Installation Directory>/ErrorPages/404.htm
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Figure 6-15: Custom Error properties for 404 errors

6. In order to “Not Found” page being shown for invalid .aspx addresses (e.g. Batch.aspx —
does not exist but would be a valid page name from IIS point of view) configure IIS the
following way:

- Go to properties of Default Web site.

- Select the Home Directoty tab.

- Press the Configuration button.

- Select the Mappings tab.

- Select the .aspx extention option from the list.
- Press the Edit button.

- Check the Verify that file exists checkbox.
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Figure 6-16: Configuring the ““Not Found” page to be shown

7.  After submitting, the following “Inheritance Overrides” dialog will be present.
- Choose WVC site to apply this setting.

Inheritance Overrides |

The following child nodes alzo defing the value of the “Scripttdaps" property, which
ovemndes the value you have just zet. Pleaze zelect from the list below thoze nodes
which hould uze the new walue.

LChild Modes:
Favebn eritier Select Al

| ak. I Cancel Help

Figure 6-17: Inheritance Overrides

Note: The “Not found” error page configuration is also used for standard authentication
mode.

8.  The web.config file needs to be modified. See section
below.

9. Close all of the running browser sessions prior to access the Web Verifier application.

10. Add the Windows user to the database. Please refer to the Designer User Guide for
information on how to do this.
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6.4.3. Changes to Web.config File

It is highly recommended to have two versions of the web.config file — one for standard
authentication and one for Windows Authentication. This will simplify switching between
modes.

The following list shows required steps to convert standard web.config to a web.config with
Windows Authentication enabled.

The steps generally apply to both, IS 6 and IIS 7. Exceptions are mentioned appropriately.

1. Change <authentication> section (located in the <configuration><system.web>) to the
following:
<authentication mode="Windows">
2. Remove the following line:
<forms loginUrl="Login.aspx" defaultUr|="BatchView.aspx" />
This is a child of the <authentication> section, and is only needed for standard
authentication.
3. Change <authorization> section (located in the <configuration><system.web>) from
‘deny’ to ‘allow’:
<authorization>
<allow users="?"/>
</authorization>
4.  Add enableSessionState attribute to <pages> section (located in the
<configuration><system.web>):
<pages enableSessionState="true">
5. Remove all <location> sections (located in the <configuration> right before
<appSettings>). Those sections look like the following:
<location path="WL">
<system.web>
<authorization>
<allow users="*" />
</authorization>
</system.web>
</location>
6.  This step only applies to IIS 6.
For correct display of ‘Not Found’ error page add section <customErrors> after
<authorization> section to be the following
<customErrors mode="0n" defaultRedirect="~/Error.aspx">

<error statusCode ="404" redirect="~/ErrorPages/404.htm" />
</customErrors>
The page referenced here is the same 404.htm that was configured in IS settings.
This “Not found” error page configuration is also used for standard authentication mode.

6.4.4. Reverting Back to Standard Authentication

To switch from Windows Authentication mode back to standard authentication mode, the
following adjustments to IIS are required:
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IS 7.x (Windows 7, Windows Server 2008, Windows Server 2008 R2)

Please refer to of section . Disable Windows Authentication and enable both,
Anonymous and Forms Authentication.

IIS 6 (Windows Server 2003)

Please refer to of section . Disable Windows Authentication and enable
Anonymous Authentication.

Changes to Web.config

Get the back up file which was done at the beginning of the configuration process.

6.5 Configuring SSL for Web Verifier

For information how to set up SSL on your Information Services machine please refer to:
http://support.microsoft.com/kb/299875

6.6 Configuring Additional Languages

Web Verifier supports an extended list of languages:

Chinese Simplified, Chinese Traditional, Danish, Dutch, English, French, Finnish, German,
Italian, Japanese, Korean, Norwegian, Polish, Portuguese, Romanian, Russian, Spanish,
Swedish, Turkish.

Note: By default, the Chinese language selection points to Traditional Chinese. In case
Simplified Chinese language has to be used, the content of the Bin\Resources\cmn folder can
be copied into the "zho" folder which contains the Traditional Chinese. Prior to overwriting the
“zho” folder content, please back it up..

6.7 Virus Check

Please note, that the settings for the Virus Checker on the Web Server exclude the [Local
Temp Folder)/CdrDbCache directory (Batch and the Common Learnset folders) from the
locations which are checked for viruses. This is due to performance considerations.

6.8 Enabling New Columns for Batch View
Four additional columns are available to hold additional information on batches:
e Batch.ExternalGroupld - default display name: "User Group"

data type: The Group ID which has been assigned to a batch is relating to security.
Batches can be assigned to user group via a unique ID. For example, German invoices
belong to Group 1 and English invoices belong to Group 2. When in a shared service
center, you could hide all German invoice batches from English Verifiers.

e Batch.ExternalBatchid - default display name: "Batch Group"

data type: It allows the developer to uniquely identify the batch. For example, external
system ID, storage box ID, etc.

e Batch.Transactionld - default display hame: "Transaction"

data type: It allows the developer to synchronize a newly created batch of documents with
another external system. It can be used to identify originators of batch of documents.

e Batch.TransactionType - default display name: "Transaction Type"
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data type: It allows the developer to synchronize a newly created batch of documents with
another external system. It can used to identify the types of documents (Invoices, Claim
forms etc.) in batches or source of document (Email, Scanned etc.)

These table columns are not Perceptive Intelligent Capture project or application specific and
therefore cannot be configured in Designer or Verifier or RTS applications.

By default, these columns will be invisible. To configure the columns’ visibility for Web Verifier,
adjust the batch columns’ attributes in the batchColumnVisibility section of the web.config file
appropriately (please refer to ).

The values of the columns can only be set via the Project Script (PostimportBatch). Check the
SQL scripts in the installation folder to activate the displaying of those columns. After enabling
one or all of the additional columns in database, it applies to all application modules.

The additional columns can be enabled with columns customized.

For SOL:
Syntax:

exec sp_SetGlobalApplicationSetting “ColumnSettingName®, “Column Name to Display”®,
Enabled boolean

Examples:

exec sp_SetGlobalApplicationSetting "SysAppBatchColumnExternalGroupld®, "User Group”®,
True

exec sp_SetGlobalApplicationSetting "SysAppBatchColumnExternalBatchld®, "Batch
Group®™, True

exec sp_SetGlobalApplicationSetting "SysAppBatchColumnTransactionld®, "Transaction”,
True

exec sp_SetGlobalApplicationSetting "SysAppBatchColumnTransactionType®, "Transaction
Type®, True

Note: For setting up the Group ID column, due to the security control, make sure the
group ID is matching with the ID created for the users.

For Oracle:
Syntax:

exec sp_SetGlobalApplicationSetting “ColumnSettingName®, “Column Name to Display”,
Enabled Boolean

Examples:

exec sp_SetGlobalApplicationSetting "SysAppBatchColumnExternalGroupld®, "User Group”®,
1

After you have enabled new custom columns following the instructions in section 6.8,
, You may want to give them more meaningfull
names.

To change the custom column names for the Web Verifier application:

1. Navigate to C:\Program Files (x86)\Perceptive\Perceptive Intelligent Capture Web
Server\Bin\Resources\eng
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2.  Open the file in notepad: Brainware.Verifier. WebClient.resx
3. Change the name of the four items below by adjusting the value parameter (highlighted
in red in the sample below):

Example:
<data name="TEXT_EXTERNALBATCH_NAME" xml:space="preserve">
<value>External Batch ID</value>
</data=>
<data name="TEXT_EXTERNAL_GROUP_ID" xml:space="preserve">
<value=>User Group</value>
</data=>
<data hame="TEXT_TRANSACTION_ID" xml:space="preserve">
<value=>Transaction ID</value>
</data=>
<data name="TEXT_TRANSACTION_TYPE" xml:space="preserve'">
<value>Transaction Type</value>

For the other application languages, repeat the steps outlined above using the appropriate
Brainware.Verifier.WebClient.resx file from the appropriate folder under:

C:\Program Files (x86)\Perceptive\Perceptive Intelligent Capture Web
Server\Bin\Resources\....

6.9.2. Custom Column Names for Thick Verifier Client

For the Thick Verifier Client, custom column names can be changed via SQL Script. Run the
below mentioned script by changing the ‘Column Name to Display’ value.

Syntax:

exec sp_SetGlobalApplicationSetting “ColumnSettingName®, “Column Name to Display”®,
Enabled Boolean

Example:

exec sp_SetGlobalApplicationSetting "SysAppBatchColumnExternalGroupld®, "User Group-®,
True

6.9.2.1. Global Application Setting Configuration

This setting is taken place in SQL server, and it enables/disables Workflow History Reporting,
disables Batch Deletion in Designer/ MMC, and enables some additional custom columns.

This feature allows user to enable/disable for Document Level, Field Level, table Level,
Classification, Document Separation, Learning, etc.

Note: This feature is only available for the Database.
To execute the setting:

1. Launch the SQL Server Management Studio.
2. Point to the Perceptive Database.
3. Type in the following script:

exec sp_SetGlobalApplicationSetting "SysAppHistoryReportingActivatedForDocument”,
"True®, True
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Figure 6-18: SQL Server
Setting Name is the text name of the setting to be modified for application.
Setting value is the text value to configure for it.

Status Flag contains True (Setting enabled) or False (Setting disabled). This is disabled by
default in the current version of Perceptive Intelligent Capture.

To enable item with Document Level:

exec sp_SetGlobalApplicationSetting "SysAppHistoryReportingActivatedForDocument®,
"True®, True

To enable item with Field Level:

exec sp_SetGlobalApplicationSetting "SysAppHistoryReportingActivatedForField”,
"True®, True

To enable Batch Deletion in Designer (Default setting):

exec sp_SetGlobalApplicationSetting "SysAppBatchDeletionDisabledInDesigner®, "True®,
False

To disable Batch Deletion in Designer:

exec sp_SetGlobalApplicationSetting "SysAppBatchDeletionDisabledInDesigner®, "True®,
True

To enable Batch Deletion in RTS (Default setting):
exec sp_SetGlobalApplicationSetting "SysAppBatchDeletionDisabledInRTS", "True®, False

To disable Batch Deletion in RTS:
exec sp_SetGlobalApplicationSetting "SysAppBatchDeletionDisabledInRTS®, "True®, True

Figure 6-19: Delete Batch Function is Disabled in RTS

It takes immediate effect right after you have configured it in the SQL Server and it applies to
all users under the Perceptive Database.
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Perceptive Intelligent Capture contains an internal application security model with 5 project
security roles:

- Administrator: The Administrator’s role (ADM) is to manage users, groups, and user-to-
group assignments. Administrators install the system, configure applications, and manage
data. They also design and maintain projects. This role is the most powerful of the roles
because it is the highest role within Perceptive Intelligent Capture.

- Learnset Manager: The Learnset Manager (LSM) role is used to define, modify, and
maintain the global project Learnset. Reference Perceptive Intelligent Capture Designer
and Verifier documentation for additional information.

- Supervised Learning Verifier: The Supervised Learning Verifier (SLV) role is to collect
and manage the local training data. These verifiers are subject-matter experts who can
propose Learnset improvements.

- Verifier User: The Verifier role (VER) is to make document correction that could not be
automatically processed. Typically members of this group are data correction users.

- Setting Role: The Verifier Settings (SET) role is used to give permission to the Verifier
(VER) to alter or access the verifier configuration settings.

- Filtering Role: The filtering role (FLT) is to allow Verifier user to configure custom filtering
of batches. By application design, FLT users would be able to use the filtering feature
even if they do not have the SET role. This solution provides more flexibility and security.

Note: Additional information on adding users and groups can be found in the Designer
documentation.

Local workstations and network Windows users can be imported into the Perceptive Intelligent
Capture project authentication sub-system allowing automatic project authentication with the
currently logged in Windows user account for all Perceptive Intelligent Capture applications.

To enable Windows based authentication in Perceptive Intelligent Capture for a desired
Perceptive Intelligent Capture project:

1) Open the corresponding project file in the Perceptive Intelligent Capture Designer
application

2) Select Options, Users, Groups and Accounts... menu item

3) Enable Allow Windows Authentication check-box on the Users tab of the Project
Authentication Settings dialog
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Project Authentication (User ID: Administrator) Properties

Users |Gr0ups| Change Pazsword

 User
Name: IAdministrator |
Mew... Delete
Laocal Project I |
Common Falder I |
[ Use database as knowledge source
Select.lob I j
[~ Group Membership
Awvailable Groups: Aszsigned Groups:
Groué Name I Descriétic Grnué Mame I Descriétic
LSM Superwi... Aidrnin
Werlfier User Add s> |
SLw User
<< Remaove |
D D Bl
[~ Enable password remembering for user logon dislog
v asllow Windows Suthentication Windaws Import |
[~ Allow Database Authentication
Export to Database... | Impaort from File... I Expart to File... |

oK I Cancel | Apply |

Figure 7-1 Perceptive Intelligent Capture Project Security

When using Database Authentication in Verifier, access rights have to be granted to the
verifier user.

By default, this should be:
- Read and Write to all database tables

- Execute rights to stored procedures and functions.

7.2  File System Security

Although Perceptive Intelligent Capture does provide application-level security, the product
relies on integrated Windows file system security built into the underlying operating system for
file system access.

Perceptive Intelligent Capture uses operating system files (.sdp, .dat, .wdc, .sdb, etc.) to store
all application and project data. A combination of shared and NTFS permissions are used to
protect application data.

NTFS file and folder permissions are used to control the type of access that a user, group, or
application has to folders and files. This includes everything from reading the contents of a
folder or a file to modifying a folder’s contents and/or executing individual files. There are five
basic NTFS file and six folder permissions:

File Permission Access Granted

Read Allows the user or group to read the file and view its attributes, ownership, and the
permissions set.

Write Allows the user or group to overwrite the file, change its attributes, view its ownership, and
view the permissions set.

Read and Allows the user or group to run and execute the application. In addition, the user can perform
Execute all duties allowed by the Read permission.
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File Permission Access Granted

Modify Allows the user or group to modify and delete a file including performing all of the actions

(CHANGE) permitted by the Read, Write, and Read and Execute NTFS file permissions.

Full Control Allows the user or group to change the permission set on a file, take ownership of the file,
and perform actions permitted by all of the other NTFS file permissions.

Table 7-1: NTFS File Permissions

Folder Permission Access Granted

Read Allows the user or group to view the files, folders, and subfolders of the parent folder. It also
allows the viewing of the folder attributes, ownership, and permissions.

Write Allows the user or group to create new files and folders within the parent folder, view folder
ownership and permissions, and change folder attributes.

List Folder Allows the user or group to view the files and subfolders contained within the folder.
Content

Read and Allows the user or group to navigate through all files and subfolders, and to perform all
Execute actions allowed by the Read and List Folder Contents permissions.

Modify Allows the user to delete the folder and perform all activities included in the Write and Read
(CHANGE) & Execute NTFS folder permissions.

Full Control Allows the user or group to change permissions on the folder, take ownership of it, and

perform all activities included in all other permissions.

Table 7-2: NTFS Folder Permissions

The difference between NTFS file and folder permissions is the “List Folder Contents NTFS”
folder permission. NTFS folder permissions enable system administrators to limit a user’s
ability to browse through a tree of folders and files. This is useful for securing a specific
directory such as an application directory. A user must know the name and location of a file to
read or execute it when this permission is applied to its parent folder. However, in a Perceptive
Intelligent Capture environment, client applications in the product suite, instead of Windows
Explorer, are used to process project data. The intent of file and folder permissions is to
minimize the probability of accidental or malicious data destruction.

Shared permissions serve for purposes similar to NTFS permissions: They help protect files
from unauthorized access. If you are a member of the Administrators or Power Users group,
you can share folders on a local computer so that users on other computers can access those
folders over the network. By assigning shared folder permissions to any shared folder, you can
restrict or allow access to those folders over the network. Use NTFS folder permissions if the
shared folder is located on a NTFS drive. NTFS permissions are effective on the local
computer and over the network.

For more information regarding folder permissions, reference
7.3  Access to Project Data

Perceptive Intelligent Capture uses a hierarchical file structure to store project-related data.
The project directory is at the highest level of this structure.
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Figure 7-2: Project Directory.

All Perceptive Intelligent Capture components (including services, applications, license engine,
and users) need appropriate access rights to the project directory and all of its subfolders.

See section for details on how to enable access to project data.

Once Perceptive Intelligent Capture has been installed, configured, and prepared for
production, appropriate file access security should be applied to the project directory before
releasing the implementation to the general user community. A correct application of file
access security can prevent unauthorized access to project data while granting access to
authorized users.

To apply file access security to the Perceptive Intelligent Capture project directory:

2) Launch Windows Explorer on the Perceptive Intelligent Capture server (or the server
containing the project directory).

3) Locate the project folder, right click the folder name, and select Properties.
4) In the Properties dialog box, go to Sharing tab.

5) Click Share this folder.

6) Inthe Share name field, type a name for the share.

7) Click Permissions. In the Share Permissions dialog box, do the following tasks, and then
click OK:

- Add the local Perceptive Intelligent Capture group with Full Control permission

- Add the local Perceptive Intelligent Capture Users group with Change permission
- Add the local Administrators group with Full Control permission

- Remove the Everyone group

8) Go to Security tab.

9) Do the following tasks and click OK when finished:

- Add the local Perceptive Intelligent Capture group with Full Control permission

- Add the local Perceptive Intelligent Capture Users group with Change permission
- Add the local Administrators group with Full Control permission

- Remove the Everyone group

Note: The Perceptive Intelligent Capture and Perceptive Intelligent Capture Users groups
are local groups. The Perceptive Intelligent Capture local group should be created on all
Perceptive Intelligent Capture servers and RemoteAdmin machines; the Perceptive
Intelligent Capture Users local group is only required on the Perceptive Intelligent Capture
server storing the project data. For an explanation of these groups, see next section.

Access to project data in a Perceptive Intelligent Capture implementation should be granted
using a combination of Discretionary Access Control (DAC) and Role-based Access Control
(RBAC).
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The Discretionary Access Control model allows the owner of objects or resources (in this
context, a System Administrator) to control who accesses them and what operations they can
perform. For example, a System Administrator who creates a share called “Projects” to hold
data pertaining to a particular Perceptive Intelligent Capture project can control and dictate
(per the organization’s security policy and business rules) who can access the items within the
share.

The Role-Based Access Control model, also referred to as a non-discretionary model, makes
access decisions based on the rights and permissions granted to a role or groups, instead of
an individual. In this model, System Administrators create roles (or groups), and then assign
rights and permissions to the role (or group) instead of directly to a user; users are then placed
into a role (or group) and inherit the rights and permissions assigned to the role (or group).

The following table lists the recommended groups and accounts that should be created for
each implementation of Perceptive Intelligent Capture:

Group/Account Name ‘ Purpose

Perceptive Intelligent
Capture ProjectUsers

Global group containing all users designated as a Perceptive Intelligent Capture project designer
and/or data verifier within an organization.

Perceptive Intelligent
Capture Admin

Global group containing all users designated as a Perceptive Intelligent Capture System
Administrator within an organization. This group should be added to the local Perceptive
Intelligent Capture group on all RTS servers and RTS Remote Admin workstations.

Perceptive Intelligent
Capture

Local group used to grant access to local Perceptive Intelligent Capture resources; the
Perceptive Intelligent Capture Admin global group should be added to its membership. Create
this group on all Perceptive Intelligent Capture Server and RemoteAdmin machines

Perceptive Intelligent
Capture Users

Local group used to grant access to the project directory. Add the global group Perceptive
Intelligent Capture ProjectUsers to its membership. Create this group on the Perceptive Intelligent
Capture server housing the project directory.

Perceptive Intelligent
Capture RTSsvc

Service account used to start the Perceptive Intelligent Capture Service Manager. This user
should be a member of the Perceptive Intelligent Capture Admin global group and the local
Administrators group on all Perceptive Intelligent Capture servers and Remote administration
machines.

Table 7-3: Recommended Group/Account Names for Perceptive Intelligent Capture.

The following table

Perceptive Intelligent Capture:

Group/Account Name Permission Type:

Permission Type: Folder/Objects Assigned On

Shared NTFS

Perceptive Intelligent Full Control Full Control C:\Program Files\
Capture [company]\
[ProjectName]
Perceptive Intelligent Change Modify C:\Program Files\
CaptureUsers [company]\
[ProjectName]

Table 7-4: Group/Account and Permissions.

For a comprehensive list of security settings and options, see Appendix B.

Perceptive Intelligent Capture

lists the groups and accounts, assigned permissions, and the
folders/objects on which the permissions should be applied for each implementation of
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7.5 Configuring the Service Account for Perceptive Intelligent
Capture

7.5.1. Running Perceptive Intelligent Capture on a Domain Network

Perceptive Intelligent Capture Runtime Server Service utilizes a Windows Service which runs
in the Server background. This Service manages the operation of Runtime Server Instances,
and processing of documents automatically.

When running Perceptive Intelligent Capture on multiple servers located on a Domain
Network, it is recommended that the Perceptive Intelligent Capture Runtime Server Service is
assigned a Domain user against the Windows Service. This will allow Perceptive Intelligent
Capture to communicate with all servers running the service across the Domain.

The Service Account used in Perceptive Intelligent Capture is also given permission to any
file/folder shares across the servers to allow the Perceptive Intelligent Capture Runtime Server
service access to all project related files.

7.5.2. System Monitoring

The System Monitoring service is used to send email notification to selected users to notify of
any errors, or warnings, that any Runtime Server instance may raise during its operation.

The Service User Account used for System Monitoring should have sufficient rights to be able
to send emails on the server and Domain.

7.5.3. Email Importing and Service User Accounts

Perceptive Intelligent Capture provides the ability to perform email importing, automatically
downloading emails from a Mail Box account and importing it into the Perceptive Intelligent
Capture system. The Perceptive Intelligent Capture Runtime Server Service must have
sufficient access rights to be able to access the mailbox in order to download emails for
process.
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Chapter 8 Configuring Runtime Components

Once you install Perceptive Intelligent Capture you must configure the Runtime Service
Manager before you can use the application.

8.1 Before Configuring Components
Check the following pre-installation steps before you configure Runtime Components.

Before starting the Perceptive Intelligent Capture Runtime Service Manager on a license
server (a machine equipped with a hardware-key intended to provide a shared network copy of
the license file to other Perceptive Intelligent Capture machines) or a standalone machine
(laptop or an autonomous Perceptive Intelligent Capture machine), ensure that:

e A hardware key is installed

e The corresponding license file for the installed hardware key is copied to the
...\Perceptive\Components\Cairo directory

e The demo license file, zCroDemo.lic, is deleted from the ...\Perceptive\Components\Cairo
directory

8.2  Configuring the Runtime Service Manager

Below are the steps required for configuring the Runtime Service Manager. Administrator
rights are needed to do these steps:

1) Click Start on the lower left of your screen.
2) Click Run.
3) Atthe command window, type “services.msc” and press Enter.

Figure 8-1: Runtime Service Manager in Services

4) In the Scope panel, double click the Perceptive Intelligent Capture Runtime Service
Manager.
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Figure 8-2: Runtime Service Manager Properties dialog box
5) On the General tab, under Startup type, select Automatic from the drop down list.
6) Goto Log On tab.

Figure 8-3: Log on tab for Runtime Service Manager Properties dialog box
7) Under Log on as, select This account.
8) Click Browse...

9) Find and add the domain user with appropriate and sufficient for Perceptive Intelligent
Capture processing network access rights (e.g. Perceptive Intelligent Capture RTSsvc),
and then click OK.

10) Type the domain password for the user in the fields provided.
11) Click Apply and OK, and then close the Computer Management MMC.
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The installation of Perceptive Intelligent Capture creates a default console, called Perceptive
Intelligent Capture Service Manager that you can use to configure the Perceptive Intelligent
Capture RTS RemoteAdmin MMC snap-in.

Very Important!

Before configuring the RemoteAdmin MMC snap-in, make sure that the steps
outlined in section 8.2 have been performed and the Runtime Service Manager is
started. Unless the service has been started, the MMC will not connect to the
machine.

1) Launch the Perceptive Intelligent Capture Service Manager MMC snap-in by selecting
Start>Programs>Perceptive>Perceptive Intelligent Capture>Perceptive Intelligent Capture
Runtime Service > Management Console on the desktop of the target machine. The
Perceptive Intelligent Capture Service Manager MMC console appeatrs.

Figure 8-4: The administration console

2) Right click the Perceptive Intelligent Capture Runtime Server node and select New
Perceptive Intelligent Capture RTS Group from the context menu.

3) Onthe New Group dialog, type a group hame and click OK.

4) Expand the Perceptive Intelligent Capture Runtime Server node, right click the group you
created, and then select New Machine.

5) Inthe Domains dropdown, select the domain where the machine being configured locates.

Figure 8-5: Group management of runtime service

6) On the Group Management dialog box, type the name of the Perceptive Intelligent
Capture server and click OK.
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Figure 8-6: Administration console with added machine
7) Right click on the machine name. Select License, and set the license path.
8) Right click on the machine name and select New>RTS Instance

9) On the New RTS Instance dialog, type the instance name and then click OK. The
configuration for RTS RemoteAdmin MMC snap-in should look like the example in

Figure 8-7: Administration console with instance
See Also

For information on how to configure project settings for a Perceptive Intelligent Capture
instance, see the Perceptive Intelligent Capture Runtime Server User’s Guide.

8.4  Configuring E-mail Import

Below are the steps required to configure the E-mail Import feature for Microsoft Office 2003.
They may be slightly different for other versions of Microsoft Office.

1) Launch the Windows Control Panel and select the Mail option
Note: Microsoft Outlook must be installed before this option appears in the Control
Panel.

2) Click Show Profiles.... Click Add... and create a new profile named RTS_Import, and then
click OK.

3) Select Add a new E-mail account and then Next. Select Microsoft Exchange Server.
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4)

5)
6)

7)

8)

9)

Enter the name of your Microsoft Exchange Server. Switch off Use Cached Exchange
Mode. Enter the User Name and click Check Name to make sure that mailbox is
recognized.

Click Next then click Finish to create the account and close the wizard.

Open your “\Perceptive\Perceptive Intelligent Capture” folder in Windows Explorer and
create a batch file containing the following line: “DstHost.exe /TestMailUI”. Run the batch
file. The Outlook logon screen should appear.

Enter “[your domain name]\[your user name]” as the user name and your password. Check
the Remember password option otherwise your RTS service may not work.

Open the latest “I_YYYYMMDD_Perceptive Intelligent Capture
RuntimeServiceHost_PID.log” file in the “.\Perceptive\ Perceptive Intelligent Capture\Log”
folder and verify whether the login was successful by checking for the message: “Managed
to open the folder Inbox™ or any corresponding errors.

Create and run another batch file containing the following line: “DstHost.exe /TestMail”.
You should get the same message in the log file as in the previous step i.e. “Managed to
open the folder ‘Inbox™, but without any dialog asking you for the user name and
password.

10) See the Perceptive Intelligent Capture Runtime Server Guide to complete the

configuration process.

The standard Runtime Server Log includes System Level Resource information and, in the
event of a system crash or failure, special error logs.

In the Perceptive Intelligent Capture\bin\Log folder, the log files for the different Perceptive
Intelligent Capture components can be found as following:

V_ log file for Verifier messages, e.g. any custom script errors would be logged there.
H_ log file for Runtime Server messages.
VA_ log file for Advanced Verifier messages.

L_ log file for Learnset Manager messages, e.g. when the user triggers document
learning, or when a backup of the Learnset is taken, etc.

D_log file for Designer messages (including scripting errors).
U_log file for Unknown/External application messages.
S _log file for Standart Service Manager messages.

The |_ log files are component log files for all applications and are written to by the
application during the normal running.

Examples for file name syntax, e.g. for the Runtime Server log file:

[Application directory]\bin\Log\H_<instance name>_yyyymmadd.log

For example:
C:\Program files\Perceptive\Perceptive Intelligent Capture\bin\Log\H_Test_20100203.log

Standard Service Manager log file:

[Application directory]\bin\Log\S_yyyymmdd.log
For example:
C:\Program files\Perceptive\Perceptive Intelligent Capture\bin\Log\S_20100203.log
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The following System Resource information has been added to the log files:
e Available physical memory (in kb).

e Used physical memory (in kb).

e Available virtual memory (in kb).

e Used virtual memory (in kb).

¢ Virtual memory used by this RTS host instance process (in kb).

e Physical memory used by this RTS host instance process (in kb).

e Handles used by the process (in number of handles).

e GDI resources used by the process (in number of handles).

e User Objects used by the Process (in number of Objects).

Using the following format:

Entry Nr. Entry Description

1 Type of message (info, warning, error, etc)

2 Severity of message

3 Time logged

4 Process ID (PID)

5 Overall used/available physical memory

6 Overall used/available virtual memory

7 Used physical/virtual memory by this Runtime Manager

8 Process handles used by this Runtime Manager

9 GDI resources/UserObjects used by this Runtime Manager
10 Message Description

Table 8-1: Log files format

S _log example:

[Infol |30] 00:35:26.146 | 2628 | 2663792k/14110392k | 2983264k/24429476k | 51660k/18932k |
154 | 4/14 | Sent "13" to Host "5.2FullSetup-RTS" Conn: 1

H_log example

[Infol |20] 01:00:57.656 | 5584 | 1005944k/15768240k | 1097012k/26315728k | 8276k/7004k | 84
| 4/5 | Username: SYSTEM, Computername: WIN-RSL5FCPK7A4

8.5.2. Crash / Failure Logging

In the case of a System or Application Crash or Failure an additional error log file will be
created with a format:
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C_<Process 1D>_yyyymmdd. log

This will log crashes under the following circumstances.

Import Crashes - The log file will have stack information specific to the status of the system
when the crash/failure occurred.

OCR Engine Crashes - The log file will have a "ReadZone" entry for the specific OCR
engine for which the crash occurred and stack information specific to the status of the
system when the crash/failure occurred.

Classification Engine Crashes - The log file will have a "Classify" entry for the specific
Classification engine for which the crash occurred, the specific Class name where the
crash occurs, and stack information specific to the status of the system when the
crash/failure occurred.

Extraction Engine Crashes - The log file will have an "EvalZone" entry for the specific
Extraction engine for which the crash occurred, the field where the crash occurs, and stack
information specific to the status of the system when the crash/failure occurred.

Export crashes - The log file will have a "StepExport" and stack information specific to the
status of the system when the crash/failure occurred.

Clean-up crashes - The log file will have a "ProcessDocumentsCleanUp" and stack
information specific to the status of the system when the crash/ failure occurred.

Script Events - The name of the script event, which could be project level or a certain class.
For script events on field level, the field name will be added to the crash/failure log.
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The auto update feature allows the Administrator to update automatically Perceptive Intelligent
Capture software versions with latest available service updates on different workstations
where Perceptive Intelligent Capture applications are running. For this purpose, it is required
to set up a “Shared Network Folder” where the new service updates are to be placed.

The workstations must have sufficient file access permissions to access this shared directory.

Furthermore, a Local Update Folder has to exist for each workstation, where automatic
updates are to be configured. Through this directory, the system will check which software
builds have already been installed.

There are three files to be copied to the Shared Network Folder to enable automatic updates:

e One system file (called “Build Level” file for further reference) identifies the build level of the
service update to deploy automatically (for example, “B4117.installed").

e The service update to deploy automatically. (It is recommended to define a uniqgue name
associated with execution of service update installations, for example “Setup.exe”.)

¢ One batch file for execution of the service update in Silent Mode ("InstallRemote.bat").

When starting the Verifier (or Designer/RTS applications) the batch file will check whether the
same “Build Level” file located in the “Shared Network Folder is already available in the Local
Update Folder.

1. If this is not the case, the "InstallRemote.bat" is going to be invoked. After completion of the
silent installation, the “Build Level” file from the Shared Network Folder is going to be
copied to the Local Update Folder directory and the Verifier (or the other desired
application) is going to be started.

2. In case the same “Build Level” file is already available in the Local Update Folder, the silent
update step is going to be skipped and only the launching of the application is going to take
place.
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3. In order to auto-update the Runtime Server (RTS) software version, the RTS service has to
be stopped first. It is recommended to apply this operation when the RTS is not loaded with
the document processing activities. For this purpose the Windows "Winat" function can be
used, which can be configured to:

e Stop the RTS service at the specific desired time (e.g., via usage of the "Stop RTS running
as NT Service.bat" from the application directory of Perceptive Intelligent Capture).

o Start the auto-update feature (the file "Autolnstall.bat" from the Perceptive Intelligent
Capture application directory contains all required instructions).
Note: The enclosed file paths have to be adjusted manually.

e Start the RTS service at the desired time (e.g., via usage of the "Start RTS as NT
Service.bat" from the application directory of Perceptive Intelligent Capture).

The used batch files are going to be created during the full setup installation of Perceptive
Intelligent Capture. In case the Auto Update feature was not configured during the
installation, the used file paths have to be entered/adjusted in the following batch files
(after the installation): “StartlfNotlnstalled.bat”, “Autolnstall.bat“. In order to enable the
auto update feature for the Verifier and Designer applications, they have to be started via
the corresponding “DstVer_AutoUpdate.bat" (or “DstDsr_AutoUpdate.bat™) from the
Perceptive Intelligent Capture application directory.

During the Perceptive Intelligent Capture 5.5 SP1 installation, the setup will show a dialog box
for configuring of the Auto Update feature.

In order to configure the auto update during the installation, the Shared Network Folder path
has to be known before launching the Perceptive Intelligent Capture setup. The administrator
can also activate the automatic update for Verifier and/or Designer applications using the
corresponding Designer and Verifier check-box controls available in the dialog (by default,
both are deactivated).

The options have the following implication:

Activation of Designer and/or Verifier options: The program shortcuts do not call the
corresponding application directly any longer. Instead they use the generated (by the setup)
batch files “DstDsr_AutoUpdate.bat* and/or “DstVer_AutoUpdate.bat* correspondingly.

Note: these options can be activated only if the entered “Shared Network Folder” path is
valid.

Entering of the Shared Network Folder path: The setup will use this path when generating the
batch files for auto update function (See section
above).

In case the Auto Update feature was not properly configured during the Perceptive Intelligent
Capture 5.5 SP1 installation (for example, due to the reason that exact location of the Shared
Network Folder was unknown at the point of the installation), it is still possible to configure it
manually afterwards. The following steps are going to be required.

The path Shared Network Folder has to be entered in the “Autolnstall.bat”. For this purpose,
edit the "Autolnstall.bat* batch file using, e.g., Windows Notepad application (right click on the
“Autolnstall.bat” file in Windows Explorer, select Edit menu item).

@echo off

Perceptive Intelligent Capture Page 101 of 127



Installation Guide Chapter 9 Auto-Update

REM This Batch file checks the Shared Network Install folder ('SHAREDNETFOLDER™ variable) for
available

REM software service updates.

REM Please adjust the "'SHAREDNETFOLDER' variable with your network path, where new service updates are
REM going to be placed for automatic installation by Verifier and/or Runtime Service workstations.

REM

REM Example: \Your File ServerYour Perceptive Intelligent Capture Service Update Share

REM

REM "ACTIVEDIR" variable: Location of this batch file (generated automatically by the Perceptive
Intelligent Capture setup).

REM
REM (c) 2008 Perceptive Software, Inc.
REM

SET SHAREDNETFOLDER ='""\\YourNetworklnstal IServerName\YourInstal IShareName"

SET ACTIVEDIR ="C:\Programme\Perceptive\Perceptive Intelligent Capture"

IF EXIST %SHAREDNETFOLDER %\*.installed GOTO NEW_SU

echo no.updates.available.root

GOTO END

*NEW_SU

CD %SHAREDNETFOLDER %

for %1 in (*.installed) do Call %ACTIVEDIR %\StartlfNotinstalled %%1 %SHAREDNETFOLDER % %ACTIVEDIR %
CD %ACTIVEDIR %

“END

Change the content of the variable “SHAREDNETWORKFOLDER” to the network location of
the new service updates that is going to be used as the master location of the software setups
for Auto Update feature.

9.1.3.2. Change Shortcuts

The shortcuts used to start Designer and/or Verifier applications (Available in Windows Start
menu and/or on the desktop) invoke the corresponding programs directly, in case the Auto
Update function was not configured during the setup.

In order to adjust this, replace the target file “DstDsr.exe” (or “DstVer.exe" for the Verifier
application’s shortcut) with the batch file DstDsr_AutoUpdate.bat” (or
“DstVer_AutoUpdate.bat®) in the Properties of the corresponding application’s shortcut (Right
click on the shortcut and select the Properties menu item).

9.2 Usage

The Auto Update feature can be used for automation of the Perceptive Intelligent Capture
installation process and can save time in administration efforts to deploy future software
update on, e.g., 100 different production developments, and testing workstations and servers
where Perceptive Intelligent Capture is running.
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Chapter 10 Enabling Additional OCR Engine Languages

Perceptive Intelligent Capture supports many OCR engine languages. The FineReader 10
engine supports Asian languages such as Japanese, Chinese, Thai, and Korean. The main
languages, English, French, German, Spanish, and Italian are enabled by default, but for
some OCR engines you can request additional recognition languages at Perceptive.

Perceptive will confirm that the requested language is effectively supported by the desired
OCR engine and will deliver special custom language files in this case.

10.1 To Enable a Language for an OCR Engine

A language can only be processed by Perceptive Intelligent Capture if it is installed on the
server machine, and if it is present in the FineReader directory:

1. Exit all Perceptive Intelligent Capture applications.

2.  On the Perceptive Intelligent Capture servers, stop the Perceptive Intelligent Capture
Runtime Server services.

3.  Copy the custom language file(s) received from Perceptive to the .\Langfile sub-folder on
your local system.

4.  Copy the language file to the appropriate FineReader folder:

for instance: .\ Perceptive\Components\Cairo\Finereader8 on all configured Perceptive
Intelligent Capture machines.

Restart the Perceptive Intelligent Capture Runtime Server services.
Restart the client application.

Note: If not already done, you first have to enable the support of double byte and
extended ASCII character sets, (Greek, CJKT, Russian, Hebrew) for your system. The
steps depend on your operating system:

10.2 To add Input Language for Windows 7

Select Start > Control Panel - Clock, Language, and Region - Region and Language.
Click the Keyboards and Languages tab.

Click Change keyboards.

Under Installed services, click Add.

Double-click the language you want to add, double-click Keyboard.

Select the text services options you want to add.

Click OK to confirm.

N o g bk w NP

10.3 To add Input Language for Windows XP

1.  Select Start > Control Panel - Language and Regional Options.
Select the Languages tab.

Check the two check boxes for Supplemental language support.
Click Apply.

Reboot the machine.

o &~ D
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10.4 To add Input Language for Windows Vista

1. Select Start > Control Panel - Clock, Language, and Region -> Regional and
Language Options.

Click the Keyboards and Languages tab.

Click Change keyboards.

Under Installed services, click Add.

Double-click the language you want to add, double-click the text services you want to
add.

Select the text services options you want to add.

7. Click OK to confirm.

akrwpn
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10.5 To add Input Language for Windows 2008

1. Select Start > Control Panel - Regional and Language Options.

2. Click the Keyboards and Languages tab.

3.  Click Change keyboards.

4, Under Installed services, click Add.

5. Double-click the language you want to add, double-click the text services you want to
add.

6.  Select the text services options you want to add.

7.  Click OK to confirm.

10.6 To add Input Language for Windows 2003

Select Start & Control Panel - Regional and Language Options.
Select the Languages tab.

Under Supplemental language support, check the two check boxes.
Click OK or Apply.

Reboot the machine.

abrwdE
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This section summarizes Product Bulletins which provide additional solutions to handle
problems within Perceptive Intelligent Capture.

The following 1SO standard PDFs are supported within Perceptive Intelligent Capture:
- 1SO 32000-1:2008

The following PDF filters are supported by Perceptive Intelligent Capture:
- ASCII85Decode

- ASClIHexDecode

- FlateDecode

- LZwWDecode

- RunLengthDecode

- DCTDecode - JPEG Compression

- CCITTFaxDecode - Standard Fax Compression

- JBIG2Decode - JBIG standard introduced in PDF 1.4. Partial support, please reference
later chapters in this document.

- JPXDecode — JPEG 2000 introduced in PDF 1.5.
Perceptive Intelligent Capture supports both Image and Electronic PDFs.

This bulletin applies to the following Perceptive Software, Inc. applications and versions

e Perceptive Intelligent Capture versions 4.1, 5.2

The Perceptive Intelligent Capture PDF filter includes robust support for converting PDF text
content into Unicode. The process of converting PDF text to Unicode, while seemingly
straightforward, is actually fairly complex. Each PDF Text operation includes a string of bytes
that represent a series of character codes. The character code is used to select the glyph to
be drawn from the current font. Converting each character code to its Unicode equivalent
requires that the encoding of the font is well defined or that a Unicode mapping of its character
codes is included in the PDF document. There is also the possibility that the characters are
tagged with an alternate text replacement definition that overrides the text operation.

Most PDF creation tools follow the recommendations of the PDF specification with regard to
creating PDF that allows consuming applications to correctly convert character content to
Unicode. In fact, this is a requirement for a class of PDF documents known as Tagged PDF.
Unfortunately, there are numerous cases where a PDF document can be created in such a
way that it prevents the consuming application from being able to guarantee the mapping of
characters to Unicode or any other known character set. In such cases, even though the
glyphs are displayed perfectly, there is no way of knowing what character the glyph
represents. In many of these cases the consuming application can make certain assumptions
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about the character encoding that allows most characters to be correctly converted. However,
even in such cases, the application cannot be sure that the mapping is correct.

Perceptive Intelligent Capture does not support embedded fonts in PDF files. As described in
the "Overview" section of this note, some embedded fonts can also specify a custom encoding
of the characters in the font, making mapping to standard code pages impossible without
embedded font support. As a non-specific example, a custom encoding can be used that has
mapped every instance of the character "a" to "&", and the only way to decipher this mapping
is to read the encoding information from the embedded file. Otherwise, an application reading
the file will see that the file specifies a "&" and extract/display that character. Font rendering is
a service provided by the platform GUI (Windows 32). User-level applications are not
supposed to reinvent this functionality for their own purposes.

These types of embedded fonts with custom encodings *may* have font names that do not
match standard font naming conventions that you are familiar with (i.e. TT1SC0108137, T1,
T2, or some other non-human decipherable string of text), and will be listed in the PDF
Document Properties as "Encoding: Custom." They may also have standard naming
conventions, but the font used in the file is an embedded subset of the standard font, and the
author has chosen to use a custom encoding.

Since Perceptive Intelligent Capture does not support embedded fonts in PDF files, it cannot
read the custom encoding information contained in the embedded font. Without the custom
encoding information, the characters in the font do not map to standard code pages or
character maps, so the result is incorrectly mapped or "garbage" text in place of the expected
result.

You can verify the custom encoding on your own by attempting to copy text from the PDF file
in Adobe Reader into another application, such as Microsoft Word. You will also get "garbage"
data when copying from Adobe Reader, which should serve as a sign that Perceptive
Intelligent Capture is not going to be able to map the characters correctly.

If your PDF file contains many different fonts and only some of these are mapped incorrectly,
you should use the Touch Up Text Tool in Adobe Reader (under the Tools->Advanced Editing
menu) to select the problematic text and right-click to see that text's properties. The font will be
one of the properties, and you can then see if this is one of the embedded fonts or embedded
subset with custom encoding

To view the encoding used within a PDF file:
- Launch Adobe Reader and open the PDF file
- From the File menu, select the Properties menu item.

- On the Properties dialog box, select the Fonts tab.

If you have control over the PDF file creation process, one way to ensure the characters will
map correctly is to use the 'ToUnicode' map for the fonts in question. As suggested from the
name of this tag, ToUnicode provides a direct mapping to Unicode, which will allow Perceptive
Intelligent Capture to map the characters to Unicode values and extract/display/convert them
correctly.

e Contact the PDF creator and request that the documents provided do not use custom
embedded fonts.
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e Contact the PDF creator and request the embedded font. The font can be installed on the
Perceptive Intelligent Capture server which is performing the PDF to TIF conversion.

11.2 Acrobat PDFMaker 9.0 for Microsoft Outlook

This bulletin applies to the following Perceptive Software, Inc. applications and versions
e Perceptive Intelligent Capture versions 4.1, 5.2.

11.2.1. Overview

PDF Portfolios allow you to bring together content from a variety of sources (i.e., PDF, Word,
Excel, JPEG files) into one file location.

When opening a PDF Portfolio document, the user is presented with a screen allowing the
user to select a file to view, edit, or insert new files.

A PDF portfolio file contains a file extension of PDF.

11.2.2. PDF Files Created in Outlook via Acrobat PDFMaker 9.0 for Microsoft
Outlook

Perceptive Intelligent Capture does not support processing of PDF Portfolio files.

One example of this is PDF Portfolio files which are created within Outlook using Acrobat
PDFMaker 9.0. The portfolio file may contain several converted emails to PDF within the
Portfolio file.

11.2.3. How to Locate Portfolio PDF Files

The Portfolio PDF files can be identified through Adobe Reader. When opening a Portfolio
PDF, the user is presented with a screen that allows them to navigate thru the different
documents within the portfolio.

The screenshot below is an example of a PDF Portfolio displaying a collection of emails.

When opening a Portfolio PDF in Adobe Reader, you will also note that the File Menu contains
menu items for Portfolio.

Save Portfolio Ctrl+5
Save Portfolio As... Shift+Ctrl+5
Save as Text..

Save Files from Portfolio...

Attach Portfolio to Email...

Revert Portfolio
Close Ctrl+W
Portfolic Properties... Ctrl+D

11.2.4. Available Workarounds

e Contact the creator of the PDF and request that the PDFs / Documents are provided as
separate attachments.
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¢ Open the Portfolio PDF in Adobe Reader and export each attachment out of the Portfolio
into the Perceptive Intelligent Capture import folder.

11.3 Display and Conversion Problems with Character Width or
Overlapping Text

This bulletin applies to the following Perceptive Software, Inc. applications and versions

e Perceptive Intelligent Capture versions 4.1, 5.2.

11.3.1. Character Width and Overlapping Text in Embedded Fonts

Since Perceptive Intelligent Capture does not support embedded fonts (see earlier Bulletin
note), the character widths in the embedded font file cannot be read. In such an occurrence,
Perceptive Intelligent Capture will use the fonts on the operating system to render the
characters in the respective fonts. There can be differences in character/glyph width between
an embedded font and a standard operating system font; this can lead to conversion problems
between the original PDF file and the Perceptive Intelligent Capture rendering of the PDF file

One common example is problems with character spacing when converting PDFs to image
files within Perceptive Intelligent Capture.

It is worth noting that not every embedded font is going to have custom width information, so
this is not a universal symptom for any PDF file that uses embedded fonts.

11.4 JBIG2 Support within Perceptive Intelligent Capture — Gray X
PDFs

This bulletin applies to the following Perceptive Software, Inc. applications and versions

e Perceptive Intelligent Capture versions 4.1, 5.2.

11.4.1. Overview

JBIG2 is a compression used mainly within certain PDF files, such as scanned or faxed
documents, for which Perceptive Intelligent Capture includes limited support.

JBIG2 is currently not entirely supported by the Cairo components within Perceptive Intelligent
Capture, so this document discusses the known limitations with JBIG2 support.

When Perceptive Intelligent Capture processes PDFs using JBIG2 compression, the verifiers
may notice one of the following symptoms:

e Pages within the PDF appear as gray with a large X on it.

e Certain sections of the page appear as a gray square with a large X on it. Other sections in
the PDF may appear correct.

The Perceptive team has seen an increased usage of JBIG2 compression in PDF files in
recent months. Due to this increased volume of customer issues, support for JBIG2 is being
continuously expanded in each new release, including expanded support for different segment
types in the Perceptive Intelligent Capture release. Even with all the updates in the recent
versions, there are still some cases where an image might be omitted or displayed as a broken
image.

11.4.2. How to Determine if a PDF is using JBIG2 Compression

When opening the PDF in Adobe Reader, there is no method for ascertaining the compression
method used.

One way of determining the compression used within the PDF is to open the PDF in
Notepad++ and search for the text below.

JBIG2Decode
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If this text is found, then the PDF is using JBIG2 compression.
11.4.3. JBIG2 and Perceptive Intelligent Capture Support

Using JBIG2 encoding, a scanned image can be compressed up to 10x smaller than with a
TIFF G4 compression (standard Perceptive Intelligent Capture TIF compression format used).
A JBIG2 encoder will segment the input page into regions of text, regions of halftone images,
and regions of other data.

This chapter provides a high level description of some JBIG2 ‘features’, also known as
‘Segment Types'.

Segment Type Supported

Symbol Dictionary Yes (*)
Text Region Yes
Pattern Dictionary No
Halftone Region No
Generic Region Yes
Generic Refinement Region No
Page Information Yes
Profiles No
Tables No
Extensions No

(*) Symbol Dictionary is supported in Perceptive Intelligent Capture, but there are some
exceptions:

e Symbol Dictionary using Huffman decoding is supported ONLY if it is using standard
Huffman Tables. Custom Huffman tables are not supported.

e Symbol Dictionary using Symbol Refinement is supported ONLY if a symbol is refined
using only one other reference bitmap. There is a case where a symbol is refined using
more than one reference bitmap, which is not supported by Perceptive Intelligent Capture.

11.4.4. Available Workarounds

e When encountering PDFs with issues, contact the PDF creator and request that the
documents provided do not use JBIG2 Compression.

o If PDFs are generated via scanning, change the compression setting for PDF to use a
different compression method, such as CCITTFax.

When encountering an issue with a gray PDF and a large X, please contact Perceptive
Customer Support and provide them with the problematic PDF for further diagnosis.

11.5 Adobe XML Forms Architecture (XFA) PDF Files Are Not
Supported

This bulletin applies to the following Perceptive Software, Inc. applications and versions
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e Perceptive Intelligent Capture versions 4.1, 5.2.
11.5.1. Overview

In the PDF 1.5 format, Adobe Systems introduced a new, proprietary format for forms, namely
Adobe XML Forms Architecture (XFA) forms.

PDF currently supports two different methods for integrating data and PDF forms. Both
formats today coexist in PDF specification:

e AcroForms (also known as Acrobat forms), introduced and included in the PDF 1.2 format
specification.

e Adobe XML Forms Architecture (XFA) forms, introduced in the PDF 1.5 format
specification.

AcroForms are the original PDF forms technology. Designed as an integral part of PDF,
AcroForms could be described as being "native" to the PDF format. XFA Forms on the other
hand are based on XML technology and could not be described in the same way.

Adobe XFA Forms are not compatible with AcroForms. Creating XFA Forms for use in Adobe
Reader requires Adobe LiveCycle Forms Designer. Adobe Reader contains "disabled
features” for use of XFA Forms, so that will activate only when opening a PDF document that
was created using enabling technology available only from Adobe.

11.5.2. Adobe XML Forms Architecture PDF Files and Perceptive Intelligent
Capture Support

Perceptive Intelligent Capture does not support Adobe XML Forms Architecture (XFA) PDF
files. As described in the "Overview" section of this note, this technology is not native to PDF
Files.

Perceptive Intelligent Capture does support AcroForms PDF files.
11.5.3. How to Identify an Adobe XML PDF File
The following methods are available for determining if the PDF is using XFA or not:

¢ When opening the PDF in Perceptive Intelligent Capture, there is a message appearing on
the document image “Please wait..."”. A screenshot of this message is shown below.

Please wait...

If this message is not eventually replaced by the proper contents of the document, your PDF
viewer may not be able to display this type of document.

You can upgrade to the latest version of Adobe Reader for WindowsE, Mac, or Linux® by
visiting http://www.adobe.com/products/acrobat/readstep2. html.

For morc assistance with Adobc Reader visit http://www.adobe.com/support/products/
acrreader.html

e The PDF is created with Adobe LiveCycle Designer. This can be determined by looking at
the PDF Producer properties on the document.

11.5.4. Available Workarounds

e Contact the PDF creator and request that the documents provided do not use XFA
Formatting.

e Convert the PDF from XFA electronic PDF to an image PDF.
e Print the XFA PDF and scan the document.

11.6 Oversized PDF Files Are Not Supported

This bulletin applies to the following Perceptive Software, Inc. applications and versions
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e Perceptive Intelligent Capture versions 4.1, 5.2.

Due to deviating settings of magnification level when creating PDF documents, the resulting
PDF in some cases might have an oversized image area. Especially the step of specifying the
page area during the creation process might be susceptible to errors.

Perceptive Intelligent Capture is not designed to process oversized PDF files that are greater
than A3.

When attempting to process an oversized image, the Runtime Server would show an error
during OCR saying:
“OCR Error in Engine ‘FineReader8’ at page 1: Error in memory access”.

Processing of further images would then be terminated.

The following methods are available for determining if the PDF is too big:

¢ When opening the PDF and the magnification is showing a low value, but the page fits
entirely in the document pane, it means that when the PDF is at actual size (100%), parts
of the image would be out of view and thus, the PDF is more than likely oversized.

e Another way to determine a page size is to show the page at actual size (typically 100%)
and to look at the bottom left corner of Adobe Reader, where the page measurements are
displayed. Alternatively, the document properties can also provide information on the
image/document size.

70,83 %9240 in 4 m

e Please correct the documents at source to reflect the correct image area.

e The following document sizes are supported by Perceptive Intelligent Capture: A3, A4, A5,
A6, Letter, and Legal.

¢ Image classification engine in a test project can be used to filter out oversized images from
processing (processing of Image Classification does not require OCR). A class can be
called, e.g. Rescan, with the measurements for oversized images. (see figure below)

Finimum Size

Custom Size -

Width 2100  Height 297.0 mm

b awirmunn Size

width 2100 Height 297.0 mm

Orientation Talerance
@ Potrait 2 =l %
LandScape

Bath

Perceptive Intelligent Capture Page 111 of 127



Installation Guide Chapter 11 Workaround

11.7 Running Multiple Web Verifier and RTS instances
Problem Description

When running more than approx. 12 concurrent Web Verifier user sessions or more than
approx. 14 Runtime Service instances, the system may start experiencing lack of Windows
desktop heap resources and the extra user sessions / RTS instances can be failing with
different internal memory allocation errors.

Problem Cause

The default Windows OS setting of desktop heap size for the non-interactive Windows station
often appears to be too low to host multiple simultaneously running Web Verifier or Runtime
Service instances with extensive script engine utilization.

Steps to Resolve / Recommended Configuration Changes

1.  Open Windows Registry Editor.

2.  Browse to the key
"[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Contro\Session

Manager\SubSystems\Windows]".
3. Check / modify the third argument of the "SharedSection" parameter:

SharedSection=1024,3072,512

512 (KB) is exactly the default value that causes the issue as described in the "Problem
Description" section above.

Note that for some OS versions, this default setting can be different. The table below
gives the recommended values for this setting:

# of RTS and/or WVC instances DH Size in KB

1-10 512

11-24 1024

25-36 1536

37 —-48 2048

49 - 60 2560

61-72 3072
Legend:

DH Size: Desktop heap size for non-interactive window station

# of RTS and/or WVC: Cumulative number of simultaneously running Runtime Service
instances PLUS number of concurrent Web Verifier users running on the same physical
server.

4.  After modifying this parameter reboot the server.
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To use Perceptive Intelligent Capture, you must have a runtime license. The license is stored
in a file with the extension *.lic. This file is located in the \Components\Cairo directory of the
Perceptive Intelligent Capture installation. The license file can be updated incrementally as
new components are purchased.

To check the current license status, use SCBLibVersion.exe (...\Components\Tools). From the
menu, select View>Components Licensing Info to display a list of valid licenses.

E Crodds.dl Cairo Automatic Document Separation noy ksl 20121127 .1211:89 C:\Program Files*
E Crodnnot2. di Cairo Annatation 3oy 5.5 227107 122112 C:%Program Filesh
E CroClDoc.dl Cairo CIDoc oy s 22107 122457 C:\Program Filezh
ﬂ CroColl dl Cairo Collection nay 55 22107 12224119 C:\Program Filezt
i CroCorr.dll Cairo D atak dit noy k] 20121107 122448 C:%Program Filesh
£ CroCozBC.dll Cairo Cleqs Barcode Engine o7 5.5 22147 12214 C:WProgram Filesh
E CroDoc.dll Cairo Doc oy s 22107 12208 C:\Program Filezh
ﬂ CraFRS.dll Caira FineReaderd 55 20217 . 12411:33 C:\Pragram Filzz
£ CroFR.dll Cairo Finereader » noy k] 20121107 122310 C:%Program Filesh
ﬁ Crolmg.di Cairo Image o7 5.5 2121147 122535 C:WProgram Filesh
£ CrolProc.dl Cairo Preproceszing Module oy 55 22107 122604 C:\Program Filezt
ﬂ Crakadmos5dl  Cairo Kadmos5 Engine a7 55 202107 122932 C:APragram Filezt
ﬂ CroPDFDoc.dl Cairo PDF Document Extraction 3oy 5.5 2012127 . 12:30:00 C:%Program Filesh
ﬂ CroProj.dl Cairo Project o7 5.5 2217107 122744 C:WProgram Filesh
1 CroQ=BC.dl Cairo QualityS oft Barcode Engine oy 55 202107 123028 C:\Program Filezt
E CroRc.dil Cairo Recognita Engine noy ksl 2012117 12:26:48 C:\Program Filest
E Crotw st dll Cairo *Worktest 3oy 5.5 2012107 122810 C:%Program Filesh
ﬂ Drgtdydrmir, dil Cedar Runtime Service 5514 5.55F1 22117 2717 C:WProgram Filesh
55| DetSwcCPdI Cedar RTS Seftings 5514 5551 202117 .1211:49 C:\Program Filezt

Figure 12-1: Components Licensing Info
Only licensed options are available in Perceptive Intelligent Capture.

The Perceptive Intelligent Capture installation contains a demo license file, ZcroDemo.lic,
which is valid for several weeks. When you receive your permanent license, copy the *.lic file
to the license path and remove the demo license file.

Perceptive’s licensing model uses a combination of a license file and a corresponding
hardware key. For a standalone installation, the hardware key can be attached to a local
machine that contains both the server and client components of the Perceptive Intelligent
Capture product suite.

The Perceptive licensing model is designed for a distributed client/server environment where
scalability is paramount. In this type of environment, a machine designated as the license
server houses both the hardware key and the original license file. The server generates a
centrally located network license file that is used by all other servers and clients that are part
of the Perceptive Intelligent Capture implementation.

For more information on the Perceptive Intelligent Capture licensing model, please see the
Product Licensing Guide on the installation CD. The document can also be found on the
installation folder path ...\Perceptive\Perceptive Intelligent Capture.
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Appendix A Web.Config Options

Appendix A Web.Config Options

The table below contains some items which can be modified in the Web.Config with regards to

enabling/disabling/customizing certain features.

Option Default Value Description

ADOCommandExecutionTimeOu | Web Verifier | Optional attribute. Timeout in seconds for database stored procedures

t execution. If not specified timeout from database connection string is
used.
<client ADOCommandExecutionTimeOut=10></client>

assembly Required attribute. Assembly containts custom user provider class.
<user.controller>
<userProvider.assembly="Brainware.Verifier.WebClient"
</user.controller>
Required attribute. Assembly containts custom logger provider class.
<system. logger>
<userProvider.assembly="Brainware.System.Logger" ...
</system.logger>

batchColumnVisibility Web Verifier | Configuration of additional columns in the Batch View:
Setting this attribute to true will display the External Group ID batch
column in WVC
externalGroupldColumn visible="true"/
Setting this attribute to true will display the External Batch Name column
in WvC
externalBatchNameColumn visible="true"/
Setting this attribute to true will display the Transaction ID batch column in
wvcC
transactionldColumn visible="true"/
Setting this attribute to true will display the Transaction Type batch column
in WVvC
transactionTypeColumn visible="true'"/

BatchViewPageSize 20 The number of batches to display on Web Verifier in the batch list. Any

batches exceeding that count are divided into other navigation pages.

The default value is 20, allowing for up to 20 batches to be shown in the
Web Verifier batch list.

Example
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Option Default Value Description

<add key='"'BatchViewPageSize'" value=''20"/>

cacheSize 5 An optional parameter in the web.config that allows users to specify the
number of documents to cache when working on a batch of documents.
The cache size is associated with the loading data issue. It can avoid
inaccessibility of the workstation when loading a huge amount of batches
at once.

Within the web.config file, set the value for the cacheSize property within
the <system.controllers>/<document.controller>/<document> section.

The default value is 5, which means the minimum number of document
cache is 5.

Changing the value to 1 will disable document caching.

class Required attribute. Custom user provider.

<user.controller>

<userProvider.class="Brainware.Verifier.WebClient.Core
.WebUserProvider™ ...

</user.controller>

Required attribute. Custom logger provider.
<system. logger>

<userProvider.assembly="Brainware.System.Logger.Logger
Factory" ...

</system. logger>

connectionStrings Configuration connects to database.

<connectionStrings>

<add name="Entities'" connectionString="."
providerName="System.Data.EntityClient" />

</connectionStrings>

DocumentViewPageSize 4 The number of folders to display in the Document Tree view, when
selecting Show Selected Batch. The default value, 4, denotes 4 folders to
display in Show Selected Batch view; any additional batches are shown in
subsequent navigation panels.

Example

<add key="‘DocumentViewPageSize" value="4"/>

formEvents Required attribute. Enable/disable mouse click event on fields and table
on the Verification view in Indexing mode.
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Option Default Value Description

mouseClicked enabled="true"/

Required attribute. Enable/disable tabPressed event on fields and table on
the Verification view in Indexing mode.

tabPressed enabled="true”/

Required attribute. Enable/disable itemCopied event.
itemCopied enabled="true”/

Required attribute. Enable/disable table cell select event.

tableCellSelected enabled="true”/

inspectionServerTimeout Required attribute. Time of the periodical ping the IIS server by the
process in separate mode.

<system.project>
<project. inspectionServerTimeout ="00:00:20" ...

</system.project>

inspectionTimeOut Required attribute. It is not used. Please use for this goal the session
timeout parameter .

instanceName Web Verifier | The name of the Web module that will be shown to have access the batch
list.

Example

<client instanceName="Web Verifier'></client>

licensePath “C:\My The location of the shared license file, reference documentation regarding
Shared configuration. This should point to the License Share file.
License\Runti
me.lic”
Example

<project licensePath="C:\My Shared
License\Runtime.lic" mpdDistance="19"
mpdThreshold="60"/>

loadInSeparateProcess True Required attribute. Read only. The value is ‘True' only.
pathToProjectExe BWA The location of the Perceptive Intelligent Capture Designer module
Perceptive | psiDsr.exe).
Intelligent
Capture\
bin\" Example

pathToProjectExe="C:\Program
Files\Perceptive\Perceptive Intelligent Capture\bin\"

priority ERROR Set this attribute to identify tracing level. Options are,
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Option Default Value Description

- DEBUG: Full tracing of information and errors.

- ERROR: Errors only.

Example

<priority value="ERROR"/>

reinitScript True By default, this attribute is always set to true. This will recover the script
engine whenever a script error occurs in Web Verifier application.
remoteObjectRenewal Timeout 60 Optional attribute. Remote object references are renewed at this time
period (in seconds). Defaults to 60. Minimum accepted value is 30. The
lower the number the faster unused objects free memory but this can lead
to errors for long running commands. One can increase this value if some
actions (i.e. field validation) take a while to finish with remoting error.
Note that this value should be set in both web application config
file and Brainware.System.Project.exe config file
<client remoteObjectRenewalTimeout =45></client>
scriptReplacerAssembly Required attribute. Assembly contains custom script (WinWrap) replacer
class.
<system.project>
<project.scriptReplacerAssembly=""
Brainware.System.Controllers" ...
</system.project>
scriptReplacerClass Required attribute. Custom replacer class.
<system.project>
<project.scriptReplacerClass="
Brainware.System.Controllers.Project.Script.WebScriptR
eplacer™ ...
</system.project>
ShowExtendedErrorMessages True Set this attribute to true to enable stack trace information in the error
messages appearing in Web Verifier. Messages are written to the Trace
Log file.
Allowable values are True and False.
Example
<add key="'ShowExtendedErrorMessages" value=""true"/>
slogan Empty A text message that can be displayed on the Web Verifier browser header

with corporate messages / announcements / Corporate Slogan.

Perceptive Intelligent Capture

Page 119 of 127



Installation Guide Appendix A Web.Config Options

Option Default Value Description

Trace log/ debug file 1 It keeps the debug/ trace log file under X size. Once the X size is reached,
the log is recycled/ deleted and a new log is created.

For example, below its set to 100kb, as soon as the trace.log file went
over 100kb the log file size changed to Okb and new log messages were
written.

<appender name="RollingFile"
type=""log4net.Appender.RollingFileAppender, log4net'>

<layout type="log4net.Layout.PatternLayout, log4net'>

Trace log/ debug file 2 When the file reaches X size, it is archived as trace.log.1 and a new
trace.log will be created. When the trace.log exceeds size once more,
trace.log.1 becomes trace.log.2 and the existing trace.log becomes
trace.log.1, again a new trace.log will be created.

trace.log.1

config

<appender name="RollingFile"
type="log4net.Appender.RollingFileAppender, log4dnet'>

<layout type="log4net.Layout.PatternLayout, log4net'>

system.web Standart ASP.NET configuration section:
<system.web>

<sessionState mode="InProc" ...
Cookieless="false”

Timeout=10

</system.web>

usePath Required attribute. Enable/disable using pathToProjectExe parameter. Set
this attribute to false to set pathToProjectExe parameter is current
directory.

usePing Obsolete. Nonrequired attribute. Enable/disable using pinging for remoting

objects. It's internal attribute and should be always true in production.

waitLoadTimeOut Required attribute. Timeout for initial loading of project.exe. This
parameter is used with enable option: loadInSeparateProcess = true

Table 12-1: Options for "web.config”
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Appendix B File Permission Matrix

The table below displays the various file permissions that are used within Perceptive Intelligent
Capture.

Role/Group Description

Administrators Administrator user with full access rights to all application modules and features.

Developers The groups of users that develop, maintain, and enhance projects.

Learnset Manager Typically one user in the organization responsible for maintaining the project Learnsets.

Advanced Verifiers Several users responsible for identifying documents for improvements to the project Learnset.

Standard Verifiers Data entry clerks responsible for document correction.

RTS Service User The service account responsible for running the service for automatic document processing.
Configured only on the Server machines.

Directory Groups NTFS Permissions
Full Modify Read & | List Write \[o}
Control Execute | Folder Access
Content
License Share Administrators ) ] ] 4| | ] O
Developers

Learnset Manager
Advanced Verifiers
Standard Verifiers
RTS Service User

Root Batch Administrators v M M o4} M M O
Folder Developers
Learnset Manager
Advanced Verifiers
Standard Verifiers
RTS Service User

Common Administrators ] | 4] 4] 4| 4] O
Folder Developers
Learnset Manager
Advanced Verifiers

Standard Verifiers O O O O O O ]
RTS Service User

Global Project Administrators 4] | | 4| | | O
Developers

Learnset Manager
RTS Service User

Advanced Verifiers O O M o4} M O O
Standard Verifiers

Local Project Administrators 4] ] 4] 4] 4| 4] O
Developers
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Directory

Global
Learnset

Groups

Learnset Manager
RTS Service User
Standard Verifiers

NTFS Permissions

Full Modify
Control

Read & | List
Execute | Folder
Content

Advanced Verifiers

Administrators
Developers
Learnset Manager
RTS Service User

o
-

ASSA CSV File

Advanced Verifiers
Standard Verifiers

Administrators
Developers
RTS Service User

Learnset Manager
Advanced Verifiers
Standard Verifiers

Perceptive Intelligent Capture

File Permission Matrix

Page 122 of 127



Installation Guide Appendix C Registry Options

Appendix C Registry Options

The table below contains some items which can be modified in the Registry with regards to
enabling/disabling/customizing certain features.

Default Description

Value
DumpProjectScriptCode N/A This key is available to allow Support/Certified System Administrator / Professional
Services to carry out advanced troubleshooting on any issues with script running on
the Web Verifier.

To create the registry key to provide script dumps, follow the instructions outlined
below:

1. Launch Windows Registry Editor

2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Perceptive (or
HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Perceptive for 64 bit
systems), and Cedar location.

3. Create a new REG_DWORD (DWORD Value key) and call it
DumpProjectScriptCode

4. Modify the new key created and enter the one of the following values:

3 —to enable this feature for script page export.

0 — to disable this feature.

With the feature enabled the scripting engine files can be used to review any
compilation problems, this is an advanced feature and requires advanced knowledge of
the product.

ErrorTraceDir N/A The ErrorTraceDir registry key is available for those customers who wish to place the
component tracing logs in a different location than the default Perceptive Intelligent
Capture\bin\log folder. The registry key allows the administrator to place the logs in a
specific folder location separate from the core product logs.

The registry setting is only applicable for the component logs, not for the core product
logs.

To configure a new location for Component Logs, follow the instructions outlines below:

1. Launch Windows Registry Editor

2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Perceptive (or
HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Perceptive for 64 bit
systems), and ErrorTrace location.

3. Create a new REG_SZ (String Value key) and call it ErrorTraceDir

4. Modify the new key created and enter the filepath location for component logs to be
entered. Verify that the path entered exists and the service account/user has sufficient
permissions to write to that location.
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Default Description

Value

For the change to take place, exit all Perceptive Intelligent Capture application, and
stop any services running on the machine related to Perceptive Intelligent Capture,
then launch the application and all new component logs will be written in the desired

location.
LanguageSupportWork- N/A This registry key is used within Perceptive Intelligent Capture to allow the developer to
flowSettingsVisible utilize advanced Language Support configuration and setting. This additional feature

can be enabled via the Registry using the steps outlined below:

1. On the server/machine where Designer is installed and used, launch the Windows
Registry Editor.

2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Perceptive (or
HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Perceptive for 64 bit
systems), and Cedar location.

3. Create a new REG_DWORD (DWORD Value key) and call it
LanguageSupportWorkflowSettingsVisible

4. Modify the new key created and enter the one of the following values:

a. 1 —to enable this feature to allow the developer to configure advanced options for
language conversion.

b. 0 — to disable this feature.

For the change to take place, exit all Perceptive Intelligent Capture application, and
stop any services running on the machine related to Perceptive Intelligent Capture,
then launch the application and all new component logs will be written in the desired
location.

To view the advanced options in Perceptive Intelligent Capture Designer,
1. Launch Designer application
2. From the Options Menu select Settings

3. Navigate to the Definition tab and new settings will display.

With the settings showing, the developer can utilize additional language features which
will allow them to convert words/etc to extended ASCII character set.

ASEnginePoolAllowed N/A In certain instances some duplicates in the ASE/ASSA search may not be returned
. from the vendor/customer search. In these cases it may be that the ASSA engine
CharDifference perceives these as duplicates of existing entries.

There is a configuration step that can be undertaken which can return the suspected
duplicates as well. This may slightly increase the results of the ASE pool, but also

Perceptive Intelligent Capture Page 124 of 127



Installation Guide

Appendix C Registry Options

Default
Value

Description

return potential items which were not returned in the original search.

To configure the ASE pool to return additional likely results:
- Launch Registry Editor

- Navigate to HKLM\Software \Perceptive\Cedar (or
HKLM\Software\Wow6432Node\Perceptive\Cedar for 64 bit systems)

- Create a new DWORD registry variable for ASEnginePoolAllowedCharDifference
- Close the Registry Editor

Reanalyze the document once more and any missing entries should now appear.

HideBatchReleaseDialog |0

This key allows Support/ Certified System Administrator/ professional Services to
disable the Batch Release dialog box within the Verifier, where the business does not
require prompting users on next task. The registry value can be used to determine the
next action carried out by users.

The default action of the Batch Release dialog box is to verify the next invalid batch.
When the dialog is suppressed, this value is maintained. To change to a different
action, use the Batch Release dialog box once, then change the setting accordingly
and click OK.

To create the registry key to suppress the Batch Release confirmation screen, follow
the instructions below:

- Launch Windows Registry Editor

- Navigate to HKEY_LOCAL_MACHINE\SOFTWARE \Perceptive\
Cedar (or
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Perceptiv
e\ Cedar for 64 bit systems)

-  Create a new REG_DWORD (DWORD Value key) and call it
HidebatchReleaseDialog

- Modify the new key created and enter the one of the following
values:

. 0- to enable the confirmation screen (default)

. 1- to disable/ hide the confirmation screen

For the change to take place, exit all Perceptive Intelligent Capture application, and
then launch the application again.

To view that the change has been implemented,
- Launch Verifier

- Verify the batch to completion — no dialog box should appear

This setting is available from version 5.3.

All 1

The ErrorTrace registry Key was introduced into core product logs to provide additional
trace information on any errors or warnings in the system. The default value after
installation is to record errors only related details.
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Default
Value

Description

Modify the registry values to set the value from O to either 1, 2, or 3
1-Only Errors
2-Errors & Warnings

3-Errors & Warnings&Information

To configure ErrorTrace All value:
- Launch Registry Editor

- Navigate to HKEY_LOCAL_MACHINE\SOFTWARE \Perceptive\ErrorTrace (or
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Perceptive\ErrorTrace for 64
bit systems)

- Create a new DWORD registry variable for All, set to the appropriate value of either 0,
1,2, 0r3.

- Close the Registry Editor

MaximumDiskspace- N/A This registry value controls the amount of disk space allocated for component level
UsageMB logs on this server / workstation in MB. Setting this value to “0” has the same effect as
if the value is not created at all, which is “deactivated”.
To configure the ASE pool to return additional likely results:
- Launch Registry Editor
- Navigate to HKEY_LOCAL_MACHINE\SOFTWARE \Perceptive\ErrorTrace (or
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Perceptive\ErrorTrace for 64
bit systems)
- Create a new DWORD registry variable for MaximumDiskspaceUsageMB, set to the
appropriate value in Mb.
- Close the Registry Editor
Name Type Data
(Default] REG_SZ (value not sef)
AJI REG_DWORD 0x00000003 (3)
Mgﬁjmg.m%ﬁgﬂgeusageMB REG_DWORD 0x00000500 (1280)
I?Pﬁ.'.??)ﬁ?ﬂ?ﬁ?ﬁ?ﬁ'ﬁ ...... REG_DWORD 0x00000007 (7)
TotalDaysToKeepFiles N/A This registry value maintains the number of days the old component level logs are kept

by the Perceptive Intelligent Capture server. Setting this value to “0” has the same
effect as if the value is not created at all, which is “deactivated”.

To configure the ASE pool to return additional likely results:
- Launch Registry Editor

- Navigate to HKEY_LOCAL_MACHINE\SOFTWARE \Perceptive\ErrorTrace (or
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Perceptive\ErrorTrace for 64
bit systems)

- Create a new DWORD registry variable for TotalDaysToKeepFiles, set to the
appropriate value in numeric (total days to maintain logs — the screenshot below shows
7 days).
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Value

- Close the Registry Editor

Name
(Default)
PN
__I_\_-’Iax'lmu mDiskspacellsageMB

e

Type

REG_SZ
REG_DWORD
REG_DWORD
REG_DWORD

Data

(value not set)
0x00000003 (3)
0x00000500 (1280)
0x00000007 (7)

Table 12-2: Registry Options
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